Deliverable Number: D4.14

Deliverable Title:

Survey Project Management Portal (SMaP): Manual for implementation and use for maintainers of the project

Work Package: 4 – Interactive tools for cross-national surveys

Deliverable type: Manual

Dissemination status: Public

Submitted by: GESIS

Authors: Masoud, Davari, Dafina Kurti, Evelyn Brislinger, Markus Quandt

Date Submitted: May, 2019

V1.0: May, 2019
SERISS (Synergies for Europe’s Research Infrastructures in the Social Sciences) aims to exploit synergies, foster collaboration and develop shared standards between Europe’s social science infrastructures in order to better equip these infrastructures to play a major role in addressing Europe’s grand societal challenges and ensure that European policymaking is built on a solid base of the highest-quality socio-economic evidence.

The four year project (2015-19) is a collaboration between the three leading European Research Infrastructures in the social sciences – the European Social Survey (ESS ERIC), the Survey of Health Ageing and Retirement in Europe (SHARE ERIC) and the Consortium of European Social Science Data Archives (CESSDA AS) – and organisations representing the Generations and Gender Programme (GGP), European Values Study (EVS) and the WageIndicator Survey.

Work focuses on three key areas: Addressing key challenges for cross-national data collection, breaking down barriers between social science infrastructures and embracing the future of the social sciences.

Please cite this deliverable as: Davari, M., Kurti, D., Brislinger, E., Quandt, M. (2019). Survey Project Management Portal (SMaP): Manual for implementation and use for maintainers of the project. Deliverable 4.14 of the SERISS project funded under the European Union’s Horizon 2020 research and innovation programme GA No: 654221. Available at: www.seriss.eu/resources/deliverables
Contents

Glossary......................................................................................................................5

1. Introduction ...........................................................................................................7

2. The software: eXo Platform .................................................................................8
   2.1 Version and technical terms .............................................................................8
   2.2 System architecture .........................................................................................8
   2.3 File and database design ................................................................................10

3. Installation and technical deployment .................................................................11
   3.1 System requirements .....................................................................................11
   3.2 Start up (in Tomcat) .....................................................................................11
   3.3 Installing/Uninstalling add-ons ......................................................................12
   3.4 Configuration ..................................................................................................12
   3.5 Security aspects ...............................................................................................20
   3.6 Survey project requirements ...........................................................................23
       3.6.1 Customisation/ Code modification ............................................................23
       3.6.2 Deployment of portlets and gadgets ..........................................................25

4. eXo Mobile ............................................................................................................27

5. SMaP Deployment and customisation .................................................................28

6. Customisation of User Interface .........................................................................29
   6.1 Branding ..........................................................................................................29
   6.2 Notification .......................................................................................................29

7. Working with workspaces ....................................................................................30

8. Role management ..................................................................................................32
   8.1 Add / Remove user accounts .........................................................................32
   8.2 Manage groups .................................................................................................34
   8.3 Membership types ............................................................................................36
   8.4 Permission management (type, levels) ............................................................37

9. Content administration .........................................................................................38
   9.1 Documents .......................................................................................................38
   9.2 Manage sites and pages ..................................................................................46
   9.3 Manage web content .......................................................................................53
   9.4 Unified Search .................................................................................................59

10. Communication management ..............................................................................60
10.1 General information channels ................................................................. 60
10.2 Discussion within teams ........................................................................ 60
10.3 Communication across teams ................................................................. 65

11. Workflow management .............................................................................. 66
  11.1 Projects and tasks .................................................................................. 66
  11.2 Calendars ............................................................................................... 67
  11.3 (SLC) Folder structure .......................................................................... 68
  11.4 Overview tables .................................................................................... 69

12. Monitoring and quality assurance ............................................................... 70

13. Export data ................................................................................................ 70
  13.1 Use case: user retired ............................................................................ 70
  13.2 Use case: project ends .......................................................................... 70
Glossary

**Container templates**
Are the templates which are used to contain UI components in a specific layout and displays them on the site’s page.

**Data container**
Is an object which implements the data storage. The eXo JCR can work in two modes:
- Single database: All workspaces persisted in one database. The data container uses JDBC driver to communicate with actual database software.
- Multiple databases: Each workspace is stored in a separate database.

In SMaP implementation we use single database mode to save all the workspaces in one database and store the files and metadata in that database as BLOB (RDBMS storage).

**eXo cache**
This can rely on an org.exoplatform.services.cache.ExoCache instance managed by org.exoplatform.services.cache.CacheService. All applications on top of JCR (Java Content Repository) need this caching mechanism.

**eXo container**
This class is responsible for loading all the services and components.

**External plugins**
This service allows external services and components to be added to the SMaP instance.

**Portlets**
This is a web-based application that provides a specific piece of content to be included as part of a portal page. In other words, portlets are pluggable user interface components that provide a presentation layer to information systems. There are two following types of portlet:

- Functional Portlets support all functions within the portal. They are integrated into the portal that can be accessed through toolbar links.
- Interface Portlets constitute the interface of a portal. eXo Portal consists of some Interface Portlets, such as Banner Portlet, Footer Portlet, Homepage Portlet, Console Portlet, Breadcrumb Portlet and more.

**Gadgets**
Web based software components which are based on HTML, CSS and JavaScript. They allow developers to easily write useful web apps anywhere on the web with no modification.

**Repository**
Repositories refer to one or more workspaces.

**eXo REST framework**
This is used for eXo services i.e. the components deployed inside eXo container.

**Web content**
A textual, visual or aural content that is encountered as part of the user experiences on a website. Most of the informative pages in SMaP using this data type in eXo.

**Groovy templates**
This template is widely used in the eXo website framework. Using these templates is a workaround for simplification and modification of certain core eXo portlets.

**JCR webdav**
This is a service which allows accessing a JCR repository via WebDav.

**JodConverter**
This service converts documents into different office formats and vice versa.

**Organization management**
This is a portlet that manages users, groups and memberships. This portlet is often managed by administrators to set up permission for users and groups.

**OrganizationService**
This is a service that allows accessing the Organization model. This model is composed of users, groups, and memberships. It is the basis of eXo’s personalization and authorizations and is used for all over the platform.
1. Introduction

The Survey Project Management Portal - SMaP is a concept for establishing a tailored intranet portal which serves as a virtual collaborative work environment for distributed national and international survey infrastructures. SMaP at its final shape represents a web application based on the open source project management software called eXo Platform Community Edition (CE), which is customized to most closely correspond to specific survey lifecycle requirements.

The purpose of this documentation is to guide survey projects through the implementation of their own SMaP by giving instructions about the installation and configuration of the eXo Platform and the deployment process from eXo Platform to project specific SMaP. According to the main deployment steps, the current manual is divided in three main sections:

1. Technical deployment, addresses developers of the project: includes instructions about installation, configuration and customisation of eXo Platform, chapter 2-5
2. Non-technical deployment, addresses administrators/maintainers of SMaP: description how to apply adequate concepts and customise settings on the portal, chapter 6-10
3. Further customisation, addresses survey project managers/coordinators: management of project content, community and workflow, chapter 11-13.

In this guide you will get informed about the main steps from eXo to SMaP. The first step refers to installation and configuration of the eXo Platform (CE), that is, the configuration of the server, database and software, source code modification, and installation of third-party add-ons.

After the developer customises the modules and recompiles them to complete the implementation of SMaP, the portal administrator begins the non-technical deployment, i.e. the customisation of SMaP via the intranet menu and settings. Prior to this step, the administrator needs to understand the general SMaP deployment concept.

The final step is the further customisation of the portal by the survey project management team.

Figure 1. SMaP implementation steps

The deployment concept of SMaP itself represents a standard procedure based on the stakeholder analysis as well as the experience with the pilot survey project EVS. In consultation with a survey project, a unique portal is implemented to confirm its specific needs.
2. The software: eXo Platform

Before we start describing the SMaP implementation steps, we introduce the properties of eXo Platform, which is the software basis of SMaP. For more details about the software evaluation, consult the Project implementation report (Deliverable 4.12).

2.1 Version and technical terms

eXo Platform is a full-featured application that offers many opportunities for building and deploying transactional websites, authoring web and social content, creating gadgets and dashboards with reliable capabilities of collaboration and knowledge.

The core of SMaP implementation is based on eXo website framework version 4.4. Therefore, the content of this documentation is inherited from this framework documentation. The first step to explain the modules and development is introducing technical terms.

2.2 System architecture

Hardware architecture:
The required hardware to run the SMaP server is as follows:
- Ubuntu server 14.4 (Virtual server)
- SSL certificates
- CPU: 4 Cores (Multi-core recommended, 2GHz minimum.)
- RAM: 16 Gb (max heap size = 8GB, non-heap size = 2GB and max perm size = 2GB; It is recommended you have a memory of 8GB)
- HDD: 256 GB

Software requirements:
In software architecture we introduce the software from two points of view, the required software on the SMaP server and the architecture of eXo frameworks:
- JDK 8+ is required (Set the JAVA_HOME environment variable to point to your JDK installation.)
- MySQL
- MongoDB
- Apache server
- Open office

Software requirements for developers of SMaP:
- JDK 8+ is required
- Maven (3.0.4 or later)
- Any Java IDE tool can be used, such as Eclipse, NetBean
**Framework architecture:**

The scheme presented in this section is obtained from the *eXo architecture*. All the levels used in SMaP are introduced here.

**Figure 2. Architecture of eXo platform**

![Architecture of eXo platform](https://docs-old.exoplatform.org/public/index.jsp?topic=%2FPLF44%2Findex.html)

In the core, SMaP is using Tomcat to run the website framework on the server.

In the modules level, Modules are the portlets which are placed on top of the portal. Each portlet works independent from the other. With implementing module extension on module level we are able to create a listener and catch certain actions to make the interaction between portlets possible.

In Portal level, Portlet container and Service container are used to gain access to portlets (modules) and services. Characteristics of services are as follow:

- The interface and implementation for a service are usually separate because of the Dependency Injection concept.
- Each service has to be implemented as a singleton, which means it is created only once per portal container in a single instance.
- A component equals a service. A service must not be a large application. A service can be a little component that reads or transforms a document where the term "component" is often used instead of service.

Workspaces are handled in internal storage engine, Java Content Repositories (JCR). JCR is the Java specification (JSR-170) for a type of Object Database tailored to the storage, searching, and retrieval of hierarchical data. It is useful for the content management systems, which require storage of objects associated with metadata. The JCR also provides versioning, transactions, and observations of changes in data, and import or export of data in XML. The data in JCR are stored hierarchically in a tree of nodes with associated properties. Subsequently, workspaces and data are stored in RDBMS.
2.3 File and database design

SMaP contents are stored in two separate databases based on the specification of the content. Contents of modules, documents and workspaces (repositories) and its metadata are all stored in the MySQL database. But all the content of chat service and developed portlets are stored in MongoDB.

In SMaP we used three data sources following the proposed structure in eXo framework:

- IDM: For Identity Management service.
- JCR: For Java Content Repository service.
- JPA: To store entities mapped by Hibernate.

Therefore we create three databases one for IDM, one for JCR and one for JPA.

Since SMaP users use different sets of special characters we configure the MySQL database in order to support these, for instance for creating JCR we used the following command line:

```
CREATE DATABASE plf_jcr DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8_bin
```

We first created the three databases and then granted a user access to the databases from where SMaP platform is hosted like the following command:

```
grant all on ${dbname}.* to '${username}'@'${IP}' identified by '${password}';
```

- $IP is your app server host name that accepts wildcard (for example, localhost).
- $username and $password are credentials that SMaP Platform will use to connect to the databases in MySQL.
3. Installation and technical deployment

3.1 System requirements

The system requirement is explained during introducing the architecture of the components in the introduction section.

3.2 Start up (in Tomcat)

The SMaP Platform Tomcat bundle is a ready-made package on top of the Tomcat 7 application server. So, you just need to download and extract the package (named SMaP.zip) on your server. In this guideline, $PLATFORM_TOMCAT_HOME is the folder path of the extracted package.

SMaP Platform is started with a built-in start up script file, which is start_smap.sh for Linux and start_smap.bat for windows.

```
Linux server:
wget https://drive.google.com/open?id=1igzuVwyASbeTdOV6WVsP1KRYUeiyeaqI
unzip SAMP.zip
cd smap
$PLATFORM_TOMCAT_HOME/start_smap.sh

Development mode:
$PLATFORM_TOMCAT_HOME/start_smap.sh --dev

Windows server:
Download https://drive.google.com/open?id=1igzuVwyASbeTdOV6WVsP1KRYUeiyeaqI
unzip SAMP.zip
cd smap
$PLATFORM_TOMCAT_HOME/start_smap.bat

Development mode:
$PLATFORM_TOMCAT_HOME/start_smap.bat --dev
```

Shutting down the server:

```
Linux server:
$PLATFORM_TOMCAT_HOME/stop_smap.sh

Windows server:
$PLATFORM_TOMCAT_HOME/stop_smap.bat
```
3.3 Installing/Uninstalling add-ons

To install/uninstall add-ons, use this command:

```
Linux server:
Addon install exo-x:version
Addon uninstall exo-x:version
```

This will automatically create a new part named Tasks on the left navigation bar.

In the following we list the add-ons which we installed on SMaP:

```
Linux server:
Addon install exo-task:1.1.3
Note: adding next line to config file -> exo.properties
exo.task.intranal.portalConfig.metadata = false
Addon install exo-remote-edit
Addon install exo-answers
Addon install exo-chat-community
```

3.4 Configuration

In order to configure all the properties of the eXo framework for SMaP we need to create a config file in the following path:

```
$PLATFORM_TOMCAT_HOME/gatein/conf/exo.properties
```

The file must be named exo.properties. This file contains the entire configuration to be customized. It is fully customized for SMaP and all the properties are adjusted to the SMaP purposes. There are three items which one should pay attention:

- Each property is defined on one line that conforms to the syntax: `property_name=property_value`.
- The order of the property lines does not take any effect, but it is important that you use the exact key of each property in exo.properties given in the source file.
- The text before the equal sign is the key that you should not change and the text after the equal sign is the property’s value that you can edit.

The configuration table is available in the annex.
In order to configure the JNDI data sources (IDM, JCR, and JPA) we should use the fine-tuned eXo sample configuration to connect these databases to SMaP. There are three files that have to be modified:

i. Edit conf/server.xml to remove the default HSQL configuration:

```xml
<!-- IDM Datasource for portal -->
<Resource name="exo-idm_portal" ...
  username="root" password="*****" driverClassName="org.hsqldb.jdbcDriver" .../>

<!-- JCR Datasource for portal -->
<Resource name="exo-jcr_portal" ...
  username="root" password="*****" driverClassName="org.hsqldb.jdbcDriver" .../>

<!-- JPA Datasource for portal -->
<Resource name="exo-jpa_portal" ...
  username="root" password="*****" driverClassName="org.hsqldb.jdbcDriver" .../>
```

ii. Add a new one. For MySQL as an example, you will just need to copy the sample in conf/server-mysql.xml

```xml
<!-- IDM Datasource for portal -->
<Resource name="exo-idm_portal" auth="Container" type="javax.sql.DataSource"
  ... username="plf" password="plf" driverClassName="com.mysql.jdbc.Driver" url="jdbc:mysql://localhost:3306/plf?autoReconnect=true" />

<!-- JCR Datasource for portal -->
<Resource name="exo-jcr_portal" auth="Container" type="javax.sql.DataSource"
  ... username="plf" password="plf" driverClassName="com.mysql.jdbc.Driver" url="jdbc:mysql://localhost:3306/plf?autoReconnect=true" />

<!-- JPA Datasource for portal -->
<Resource name="exo-jpa_portal" auth="Container" type="javax.sql.DataSource"
  ... username="plf" password="plf" driverClassName="com.mysql.jdbc.Driver" url="jdbc:mysql://localhost:3306/plf?autoReconnect=true&amp;characterEncoding=utf8" />
```

iii. Edit username, password, url (host, port and database name). Besides MySQL, if you are using Enterprise Edition, you will find the samples for other RDBMSs in conf/server-* .xml

```xml
url="jdbc:mysql://localhost:3306/plf?autoReconnect=true&amp;characterEncoding=utf8"
```
Then we configure the exo.properties file to be able to set the SQL dialect in three steps.

i. For JCR, only when you are using MySQL and database character set utf8, you need to edit gatein/conf/exo.properties file to have:

```
exo.jcr.datasource.dialect=MySQL-UTF8
```

ii. For IDM, eXo Platform detects automatically the dialect for RDBMSs listed here. Only when your RDBMS is not in the list, for example Postgres Plus Advanced Server 9.2, you will need to edit gatein/conf/exo.properties file to have:

```
hibernate.dialect=org.hibernate.dialect.PostgresPlusDialect
```

iii. Download the JDBC driver for Java and install it to $PLATFORM_TOMCAT_HOME/lib.

WebDAV (& restrictions)

The WebDAV protocol enables you to use third party tools to communicate with hierarchical content servers via HTTP. It is possible to add and remove documents or a set of documents from a path on the server. DeltaV is an extension of the WebDav protocol that allows managing document versioning. Locking guarantees protection against multiple accesses when writing resources. The ordering support allows changing the position of the resource in the list and sorts the directory to make the directory tree viewed conveniently. The fulltext search makes it easy to find the necessary documents. You can search by using two languages: SQL and XPATH.

In JCR, you plug in the WebDAV layer on the top of your JCR implementation, based on the code taken from the extension modules of the reference implementation, so it is possible to browse a workspace using third party tools (it can be Windows folders or Mac ones as well as a Java WebDAV client, such as DAVExplorer or IE using File → Open as a Web Folder).

Now WebDAV is an extension of the REST service. To get the WebDAV server ready, you must deploy the REST application. Then, you can access any workspaces of your repository by using the following URL:

```
http://host:port/portal/rest/private/jcr/{RepositoryName}/{WorkspaceName}/{Path}
```
Open in Office Configuration

With the Open in Office feature, you are able to easily edit documents, spreadsheets and presentations in the native applications installed on your client, without keeping a local copy.

By default, there are 4 labels displayed for corresponding file types as below:

<table>
<thead>
<tr>
<th>Label</th>
<th>File types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open in Word</td>
<td>docx, doc, docm, dot, dotm, dotx.</td>
</tr>
<tr>
<td>Open in Excel</td>
<td>xltx, xltm, xlt, xlsx, xlsm, xlsb, xls, xll, xlam, xla.</td>
</tr>
<tr>
<td>Open in PowerPoint</td>
<td>pptx, pptm, ppt, ppsx, ppsm, pps, ppam, ppa, potx, potm, pot</td>
</tr>
<tr>
<td>Open on Desktop</td>
<td>Non-MS Office files, such as Open Document text files (odp, ods, odt, and more) or archive files (zip, rar, war, and more).</td>
</tr>
</tbody>
</table>

As an administrator, you can easily configure the file types associated with the application named as in "Open in Word", and set a new label via exo.properties file.

- Replace $CATEGORY with any text as you want, but it should represent the application in correspondence to the file types defined in $SET_OF_FILETYPES.
- Replace $LABEL with the application label that will be displayed in the UI, for example "Word" or "MS Word".

Here are some examples:

- Changing the default labels from "Open in Word", "Open in Excel", and "Open in Powerpoint" into "Open in MS Word", "Open in MS Excel" and "Open in MS PowerPoint":

```
#MS Word
exo.remote-edit.word=docx,doc,docm,dot,dotm,dotx
exo.remote-edit.word.label=MS Word

#MS Excel
exo.remote-edit.excel=xltx,xltm,xlt,xlsx,xlsm,xlsb,xls,xll,xlam,xla
exo.remote-edit.excel.label=MS Excel

#MS PowerPoint
exo.remote-edit.powerpoint=pptx,pptm,ppt,ppsx,ppsm,pps,ppam,ppa,potx,potm,pot
exo.remote-edit.powerpoint.label=MS PowerPoint
```

- Adding a new label "Open in LibreOffice" for some Open Document Text file types:
Outgoing mail service / SMTP configuration

eXo Platform includes an email sending service that needs to be configured before it can function properly. This service, for instance, is used to send notifications of connection requests.

The service requires an external SMTP server that allows accounts to send email from applications. A suggestion is to use Google SMTP, as detailed below.

In configuration, you need to provide your account and password, and other information so that eXo Platform can connect to the SMTP server.

The configuration is well commented in the exo.properties configuration file.

Read the inline comments to understand each property. Here are some remarks:

- You need to provide SMTP server host/port, a username/password to be authenticated by that server. Others are optional.
- Typically, administrators want to mask the “From” field in the system emails with something like project@smap.gesis.org so that the receivers recognize it is robotic. Many SMTP services allow you to set from field in outgoing emails to another email address than the authenticated account. That's why here you see the property exo.email.smtp.from.
- If this parameter is not valid, the value of exo.email.smtp.username will be used instead.
- If you want to use SMTP gateway over SSL, configure a certificate truststore containing your SMTP server's public certificate. Depending on the key sizes, you may then also need to install Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files for your Java Runtime Environment.
Elasticsearch

Elasticsearch is a highly scalable open-source full-text search and analytics engine. It allows you to store, search, and analyse big volumes of data quickly. Figure below explain the difference schematically.

eXo Platform supports two deployment modes of Elasticsearch:

- Embedded mode: One node of Elasticsearch embedded in each eXo Platform instance.
- This mode is only dedicated for development and testing purposes.

- External mode: eXo Platform (deployed in standalone or cluster mode) is connected to an external Elasticsearch (deployed in standalone or cluster mode).

In the start of the SMaP project we installed several testing instances in one server with different configuration, which we could observer indexing issues on the very last installed instance. In this use case where there is more than one SMaP instances on one server, we have to use Elasticsearch in external mode to prevent indexing issues.

To use the external mode, you need to uninstall the embedded mode using this command:

```
./addon uninstall exo-es-embedded
```

or simply disable it in exo.properties by setting to false the property exo.es.embedded.enabled:

```
exo.es.embedded.enabled=false
```

Cache configuration

To retrieve and display content faster, eXo Platform uses some cache services. See Basic concepts for explanation of properties used for eXo Platform caches. All applications on the top of eXo JCR that need a cache can rely on an org.exoplatform.services.cache.ExoCache instance that is managed by the org.exoplatform.services.cache.CacheService.

The main implementation of this service is org.exoplatform.services.cache.impl.CacheServiceImpl which depends on the org.exoplatform.services.cache.ExoCacheConfig in order to create new ExoCache instances. See the below example of org.exoplatform.services.cache.CacheService definition:
<component>
  <key>org.exoplatform.services.cache.CacheService</key>
  <jmx-name>cache:type=CacheService</jmx-name>
  <type>org.exoplatform.services.cache.impl.CacheServiceImpl</type>
  <init-params>
    <object-param>
      <name>cache.config.default</name>
      <description>The default cache configuration</description>
      <object type="org.exoplatform.services.cache.ExoCacheConfig">
        <field name="name">default</field>
        <field name="maxSize">300</field>
        <field name="liveTime">600</field>
        <field name="implementation">org.exoplatform.services.cache.concurrent.ConcurrentFIFOExoCache</field>
      </object>
    </object-param>
  </init-params>
</component>
Configuring Apache

Declare a new virtual host to access your SMaP Platform instance:

```xml
<VirtualHost *:80>
  ServerName my.server.name # change here
  ServerAdmin my@server.name # change here
  # don't loose time with IP address lookups
  HostnameLookups Off
  # needed for named virtual hosts
  UseCanonicalName Off
  # configures the footer on server-generated documents
  ServerSignature Off
  ProxyRequests Off
  ProxyPreserveHost On
  ProxyVia On
  # Notifications via web socket, must be declared before the general ProxyPass definition
  <IfModule proxy_wstunnel_module>
    ProxyPass /cometd ws://127.0.0.1:8080/cometd max=100 acquire=5000 retry=5 disablereuse=on flushpackets=on # change here and adapt the options to your load
  </IfModule>
  ProxyPass / http://127.0.0.1:8080/ acquire=1000 retry=30 max=100 # change here and adapt the options to your load
  ProxyPassReverse / http://127.0.0.1:8080/ # change here
  #####################
  # Log configuration
  #####################
  ErrorLog ${APACHE_LOG_DIR}/my.server.name-error.log # change here
  CustomLog ${APACHE_LOG_DIR}/my.server.name-access.log log_with_durations # -- change here
</VirtualHost>
```
Terms and Conditions Agreement

3.5 Security aspects

Upgrade

eXo Platform aims at providing a transparent upgrade experience so that the upgrade to a newer version is seamless for an administrator.

As eXo Platform makes changes between versions, it is sometimes required to run some routines that will alter data. For that purpose, eXo Platform provides a service dedicated to it, called the Upgrade Service. This generic framework can detect a version change and identify which upgrade routines to be executed.

Since the framework leverages the eXo plugins mechanism, eXo Platform refers to these routines as upgrade plugins. At startup, eXo Platform will load and execute the upgrade plugins identified by the Upgrade Service.

The main issue with upgrading SMaP is the change in the eXo core implementation. In the customization process we changed the implementation of several portlet which makes the upgrade impossible from one stand generation to another. We aim to work on standardizing our simplification in a way that does not affect SMaP upgrade process in the future. We will discuss the details of the simplification and customization in the next section.

JAAS Realm

eXo Platform relies on JAAS for propagating the user identity and roles to the different applications deployed on the server. The JAAS realm is used by all eXo Platform applications (portlets) and even propagated to the JCR for Access Control. Therefore, if you need to change the JAAS configuration, consider that your change impacts a lot and it may require you to unpackage and modify some .war files. The JAAS configuration requires a login.config file. This file contains one (or more) entry which is called a "Realm". Each entry declares a Realm name and at least one login module. Each login module consists of a Java class and some parameters which are specified by the class.

Enabling HTTPS

Apache or Nginx can be used as a reverse proxy in front of eXo Platform. It catches https requests from the browser and proxies the requests to eXo Platform via either AJP or HTTP protocol. The following diagram depicts the case described in this section:

Browser

<table>
<thead>
<tr>
<th>SSL</th>
<th>Apache</th>
<th>HTTP</th>
</tr>
</thead>
</table>

SMaP

Before you start, note that details of Apache setup is not described here, and it depends on Apache version and your OS, so consult Apache documentation if you need.

To configure a virtual host for SSL port, the following lines should be added to site configuration (/etc/apache2/sites-enabled/default-ssl.conf)
Then we need to configure the http connector in eXo core which is in $PLATFORM_TOMCAT_HOME/conf/server.xml and then changed this configuration to:

```xml
<Connector address="0.0.0.0" port="8080" protocol="org.apache.coyote.http11.Http11NioProtocol"
    enableLookups="false" redirectPort="8443"
    connectionTimeout="20000" disableUploadTimeout="true"
    URIEncoding="UTF-8"
    compression="off" compressionMinSize="2048"
    noCompressionUserAgents=".*MSIE 6.*" compressableMimeType="text/html,text/xml,text/plain,text/css,text/javascript"
    proxyName="proxy1.com" proxyPort="443" scheme="https" />
```

**XSS Protection**

Even if the XSS protection is handled in the eXo Platform development, some protections can be added on the server side to protect against external threats. They are essentially based on HTTP headers added to the responses to ask the modern browsers to avoid such attacks.

Additional configuration options can be found on the [Content-security-Policy header definition](#).

**Secured MongoDB**

For a quick setup, the add-on by default uses a local and none-authorization connection. However, in production it is likely you will secure your MongoDB, so authorization is required. Below are steps to do this.

- Start MongoDB and connect to the shell to create a database named admin. Add a user with role userAdminAnyDatabase.
$ mongo
>use admin
>db.createUser({user: "admin", pwd: "admin", roles: [{role: "userAdminAnyDatabase", db: "admin"}]})
>exit

- Edit MongoDB configuration to turn on authentication, and then restart the server.

```
# mongodb.conf
# Your MongoDB host.
bind_ip = 192.168.1.81
# The default MongoDB port
port = 27017
# Turn on authentication
auth=true
```

- Create a user having readWrite role in the database chat (you can name the database as your desire).

```
$ mongo -port 27017 -host 192.168.1.81 -u admin -p admin -authenticationDatabase admin
>use chat
>db.createUser({user: "exo", pwd: "exo", roles: [{role: "readWrite", db: "chat"}]})
>exit
```

- Verify the authentication/authorization of the new user:

```
$ mongo -port 27017 -host 192.168.1.81 -u exo -p exo -authenticationDatabase chat
>use chat
>db.placeholder.insert({description: "test"})
>db.placeholder.find()
```

- Create a configuration file containing these below parameters.

```
dbName=chat
dbServerHost=192.168.1.81
dbServerPort=27017
dbAuthentication=true
dbUser=exo
dbPassword=exo
```
**File storage, backup and restore**

SMaP instance with all metadata, files and server configuration is backed up every day and only store the backup of the last day of week/month/year in the subsequent week/month/year.

**Password encryption**

SMaP uses Symmetric encryption of passwords; the user password is encrypted and stored along with the token. The password encryption is built against JCA (Java Cryptography Architecture) and by default uses the AES algorithm. If you do not make your own configuration, a keystore is generated with defaulted attributes (such as file name, keypass, keysize). Thus, the feature works without any effort to configure anything. However, eXo Platform allows you to configure and use your own keystore to conform to your security policy.

To update password encryption key we can use key store file:

$PLATFORM_TOMCAT_HOME/gatein/conf/codec/codeckey.txt

### 3.6 Survey project requirements

#### 3.6.1 Customisation/ Code modification

Based on the SMaP concept, different war files are re-implemented (re-compiled) and replaced with the original one. Here there is a list of each file which has been modified and must be setup on the server:

**platformNavigation.war:**

This module is responsible for the value of the labels in Home page. I changed the configuration settings and modified several .gtmpl files implementation such as: UIUserNavigationPortlet, vUISpaceNavigationPortlet, UIHelpPlatformToolbarPortlet, UICompanyNavigationPortlet

**integ-ecms.jar:**

This module is integ-ecms-social module designed for specific social implementation. It is part of lib files therefore the compiled format file is jar and should be directly copied in Lin directory. This lib overrides all the social activities on the activity stream and responsible for presentation of activities on the space activity stream. I recompiled the file completely and following files effected:

UIDocumentPreview, UISharedContent, UISharedFile, UISharedDocuments

**ecmexplorer.war:**

This module is a webapp portlet and is responsible for all the simplification on Document Management System (DMS). So many files are affected due to the massive simplification requirement such as UISelectDocumentForm, UIRightClickPopupMenu, UISelectDocumentFormListView, UIViewRelationList, UIActionBar, UISideBar, UITreeExplorer, UIViewRelationList, UITagExplorer, UIClipboard, UIAllItems

**Social-Extension.war:**

This webapp is responsible for content on activity composer and simplification of activity stream and activity composer. File which are affected include: UIActivitiesContainer, UISocialConfirmation, UIUserInvitation, UIManageAllSpaces, UISpaceSetting, UISpaceMenu, UIAddApplicationSpace, UISpaceActivitiesDisplay, UISpaceActivity, UIDefaultActivity
Social-Notification-Extension.war:
This webapp is responsible for content on activity composer and simplification of activity stream and activity composer. File which are affected include: UIActivitiesContainer, UISocialConfirmation, UIUserInvitation, UIManageAllSpaces, UISpaceSetting, UISpaceMenu, UIAddApplicationSpace, UISpaceActivitiesDisplay, UISpaceActivity, UIDefaultActivity

Message.war:
This portlet is implemented to act as messaging app. In the Forum webapp therewas a functionality so called private message app. This new webapp inherit all the functionalities from Forum.war and extend the changeTabs class

Social-portlet/social-resources (war):
This is taking care of popups over the activity stream and in order to remove the accessibility of the user to this popup, we commented out these features. This is mainly responsible for disabling social network features.

Calendar.war/jar:
We have compiled the source code of the file, so at the time of deployment three jar and war files must be replaced by the original ones in the respective version. In this implementation files such as UICalendarView, UICalendar, UICalendarSettings, UICalendarSettingDisplayTab are modified.

Task-Management.war/jar:
This file is affected by changes in the code. First of all, for PLF 4.4 we should use the branch of task-1.2.0. Newer version of the task management system is not compatible with this version of eXo. Several packages in this module got modified such as (integration, service, and task-management) and respectively UICreateTask, SpaceTaskDataInitializer, TaskServiceImpl, ProjectTaskListView, and useStateService are modified and code snippet is added.

Before installing all the above jar and war files into the server we have to keep in mind that there are some changes which have to be applied within the platform:

In order to customize the views in document you need to navigate to: Content Administration -> Document Template -> File -> view1.gtmpl and modify the Snippet of with the file attached to the downloaded source in the root named: “view1.gtmpl”

For generating the users and workspaces we developed a service which you can find in the lib folder in the root. This service uses rest APIs (rest-service.jar) provided by eXo. It is applied to create usernames and spaces and ease the process of portal administration and setup.

rest-service.jar file should be deployed in the lib directory. This library helps to create spaces automatically with the number of countries participating in the fieldwork. This implementation uses rest api and implements ResourceContainer (you can find the code snippet on repository). After deploying the file in the respected folder, you just need to hit this URL: path/rest/spaceService/SpaceCreator/root. Then country spaces will be created automatically. rest-service.jar should be deployed in order to create new users automatically. This lib helps to create new users automatically with the number of users! In this implemented lib there are two implementations: spaceCreator.java and userCreator.java which both are attached to code snippet! The rest link which takes care of the user creation is: path/rest/userService/UserCreator
3.6.2 Deployment of portlets and gadgets

We developed several portlets for different survey management purposes; in the following we explain each portlet in details. All the portlets implementation is following the same technology as follows:

- Java
- Vaadin Framework 7
- Spring Framework
- MongoDB

All these applications also follow the same architecture in terms of modules:

- Model: This module is responsible to define entities (objects which should be stored in the database) and application properties which contain information for connecting to database.
- Repository: It is responsible for configuring mongoDB and extending MongoRepository.
- Service: This module implements ApplicationContextAware to provide the application context for the entire application and implements each objects defined in service with its functionalities.
- UI: As the name suggest, this module handles the views and interface which user is interacting in front-end.
- Utils: In this module we define Enum type objects to centralize all the strings used in one application. This module simply supports multilingual website development.

After finishing the development of an application, we use `mvn clean install` command to build the latest war file. Then we shut down the SMaP instance and copy the application and other vaadin theme resources into the `$PLATFORM_TOMCAT_HOME/webapps` folder.

*The vaadin resources will be downloaded automatically with the SMaP package download and it does not need to be copied for SMaP developers.

After copying files we restart the SMaP instance and login with administrator privileges to the portal. Each new developed portlets need to be registered once in the portal. To this end, we navigate to Administration on top navigation, Application. In the right corner of the page, there are two small buttons for Portlet and Gadget. For deploying portlets we choose Portlet and then we see the list of all the portlets persisted in the webapps folder. Then we find our developed portlet in the list to register it on the portal. After registering the portlet and adding it to any category we can simply follow the customizing the web pages manual and add this portlet to the specific page.

**Online form portlet**

The online form portlet, also known as the Methodological questionnaire is a tool developed for collection and archiving of country-specific information via online questionnaire/form. For developing online form portlet we use organization service object to read all the memberships of users in groups and permissions in workspaces.

The form contains standardised questions, which are to be answered by each survey team, depending on the purpose of the questionnaire. To store the completed forms or questionnaires users are prompted to select their group/country membership under the field “Country (space)
name” in the “Home” tab placed in left navigation. In this tab you can also see all the submitted versions for all the countries/groups which you are member of. The export function provided in this submitted version allows users to download each of these versions separately in Microsoft Excel format and also download the aggregated information for all countries.

As shown in figure below, all the question items are placed in the left navigation which users should answer accordingly on the right side of the page. Questions are tightly coupled, i.e. depending on requirements, mandatory fields can change dynamically throughout the answering process.

Data deposit portlet

Data deposit is a checkbox tool designed for workflow monitoring purposes. It is characterised by the list of file items to be delivered to the central team /project management team, the information about the status of the delivery and the corresponding file version.

NOTE: Similar as the online form portlet, the content of the data deposit list of items is to be consulted and decided with the project manager before the SMaP deployment.

Interface and functions of this portlet vary between central team (project manager) and country teams. Members of each country have access only to their country-specific information under “Country Team” to fill the form and submit. A time stamp is created automatically.

One important feature of this form is the option for automatically read the status of the methodological questionnaire and fill the related boxes regarding the data deposit.
Central team members are able to access all the country-specific information, review it and check the deadline (time stamp). Further, it can export the table containing information of all countries in an Excel format.

4. eXo Mobile

Currently eXo Mobile supports iPhone, iPad and Android. You can search the apps in your device vendor’s store using "exo platform" keyword. iOS application can be used for internal portals such SMaP but Android application is for eXo Tribe community.

The app enables you to connect and collaborate on the go. It brings to you activity streams, documents and a dashboard.

Brief information of eXo Platform Mobile apps:

- **Free**
- **License: OSS License**
- **Current version: 2.5**
- **Supported Platforms:***
  - iOS 7+
  - Android 2.3+
5. SMaP Deployment and customisation

The key characteristics of deployment from eXo to SMaP are:

- Exclusion of the social networking component without restraining the transparency of workflows and communication
- Focus on collaboration within and between teams rather than individualised actions and outputs (deactivate My Activities, My Wiki, My Dashboard, personal document folder, personal calendar, create quick content)
- Organise work in workspaces by using space templates for specific purposes (including members, set of application, space settings)
- Utilise web pages for general data and information transfer
- Usage of tools and features to facilitate project workflow and progress monitoring (e.g., iFrame app linkage to google drive).

The further customisation of SMaP for a specific project depends on its requirements with regard to the organisational structure, project lifecycle, and workflows. The main areas for customisation by the project management team are:

- Create and customise workspaces
- Set up a folder structure according to the workflow (recommendation!) and add a symlink folder for sharing documents between workspaces
- Provide information and documents via content module (homepage, web pages, wiki, spaces)
- Progress monitoring by using different applications, e.g., interactive reporting form /monitoring database, calendar, task management, documents.
- Request additional apps such as Tables or Online Forms (installation only by SMaP team).

Portal administrators have access to Edit and Administration menu in the top navigation, where they can deploy and customise the portal.
6. Customisation of User Interface

6.1 Branding

You can easily brand your SMaP by changing the logo and the colour of the top navigation bar. For this, click Administration → Portal → Branding and the Branding page will be displayed:

1. **Upload** to browse and upload the project logo in the .png format from your local device, or, drag the logo from your local device and drag it into the current logo preview in the Select Logo pane.
2. **Select the navigation bar style** from the drop-down suitable to your logo. There are two styles available on the portal, consisting of Dark which is default, and Light.
3. **Preview** the displayed changes in the Preview pane.
4. Click **Save** to accept your changes.

6.2 Notification

Administrators are allowed to enable/disable notification plugins in the administrative interface. To do so, simply select Administration → Portal → Notifications on the top bar. The Activity Notification Administration page will be displayed containing the following information:

- **Notification types**: Enables or disables notification types globally.
  - **Name** and categories of the notifications.
  - **Title** of the notification that will be shown in the email.
  - **Enable** or disables sending the email notifications for each corresponding notification type.

- **Notification sender**
  - **Name**: Defines the display name of the email sender in the From field.
  - **Address**: Defines the email address of the sender in the From field. It must be in the correct form, such as username@abc.com.

As administrator you can decide which notification types and sender information all portal users should receive. However, each portal member can individually customise the settings about the stream type and frequency of notifications.
NOTE: due to the technical customisation some of the notification types have been disabled (marked with No notifications) but not removed from the list. We recommend keep these notification types as given by default to avoid confusion. All other you are free to customise based on your project tasks and workflows

7. Working with workspaces

Purpose of spaces

The Workspace concept is based on the importance of team working, allowing you to collaborate with specific people. Using spaces is flexible. According to project requirements, it can be applied for teams, themes, communities, or any kind of informal groups.

For international survey projects, we recommend setting up team-based workspaces, e.g. for each country’s national team, expert groups and, if applicable, the central or coordination team. Other way of setting up workspaces is doing it according to the stages of survey lifecycle, i.e. questionnaire design workspace, pre-test, data collection, etc.

Workspaces allow

- To quickly switch between tools
- Stay informed about team activities (messages, tasks status changes, upload/edit files and more activities trigger notifications)
- Manage contents that are private for the team
- Share files with other teams (via symlink folder).

Create/delete a space

After logging into your SMaP successfully, you will see a list of your spaces under MY WORKSPACES on the left pane of the page. If you are the project manager but the portal has a restricted role policy, you might not be entitled to add new spaces. In this case, only the SMaP administrator should create spaces and change its settings. The MY WORKSPACES list shows only the spaces which you are a member of.

Click on MY WORKSPACES leads you to the spaces overview page. To add a new workspace, click on the button + Add New Space. Automatically the Add New Space form appears. In the Settings tab, it requires at least a Name for the space.

Via the Access & Edit tab you can set the space Visibility option (the workspace is Visible/Hidden for non-members in “All spaces” list), and Registration type (Open/Validation/Closed). The option ‘Open’ implies that anybody can join the space. However, SMaP concept applies restricted role management concerning the user permissions. Therefore, users will not be able to join the workspace by themselves. ‘Closed’ option means, space membership is invitation based. ‘Validation’ is a default option and means space membership requires validation.
Invite users from group tab allows you to select a group of users to join the newly created space. Click on Create Space button to complete the procedure and move to the workspace customisation. Only portal admin can delete a workspace.

Manage space settings

Depending on the purpose, the SMaP admin or the project manager can apply specific settings and equip it with different apps. The creator of the workspace is automatically also its manager. The workspace view of the manager has an additional menu “Settings”.

A usual (country) workspace is featured by applications containing the space-filtered information. The Workspace menu includes the following apps:

- Activity Stream is for communication between team members and documentation of all workspace activities
- Tasks supports workflow management
- Documents provides access to files shared
- Forum is a platform for discussing specific topics
- Wiki collects workflow information
- Agenda informs about central and team events
- FW Report is iFrame app that allows linkage to document clouds such as google drive
- Members gives an overview of workspace members
- Settings is only visible to the workspace manager
Via the Settings tab, the workspace manager can add/edit a picture and a description of the workspace. Access & Edit tab has the same function as when creating the workspace. Workspace manager manages the workspace community by inviting/removing from users or changing the membership type member/manager. Under Applications tab manager can add or remove applications. Navigations allow changing the position and the name of the apps.

8. Role management

8.1 Add / Remove user accounts

Only the administrator who has access to administration menu is able to register new portal users.

1. Click on the top navigation bar, select Community → Add Users from the drop-down menu. A window with the Account Setting and User Profile tabs will open.
2. Add the user information in the mandatory fields (*).
3. Optional, further information about the user, such as nickname, or birthday, can be added in the User Profile tab that is not required.
4. Click Save to accept your new account. If you want to refresh the input information, simply click Reset.

To edit or remove a user account, you need to select Administration → Community → Manage community. You will be redirected to the Users tab. By default, all active users will be shown in this tab.
Editing user information

1. Locate the user you want to edit his/her information.
2. Click ☑ corresponding to the user with the information you want to edit.

A window with Account Info, User Profile, and User Membership tabs will open.

- Select the Account Info tab to edit main information of the user, including First Name, Last Name, Display Name, or Email Address.
- Select the User Profile tab to edit personal information of the selected user, including Profile, Home Info, Business Info, and Social Networks Info (if OAuth authentication is configured by your administrator). You can also switch the default display language for that user by selecting another language from the Language field.
- Select the User Membership tab to see the group membership information of the user. To remove a membership type of the use, simply click ☑.

3. Click Save to accept your changes.
To remove a user in the *Users* tab, simply click 🗑️ in the Action column and then click **OK** in the confirmation message.

The administrator is provided with a feature for activating or suspending a user. To suspend a user, switch **Active ?** button corresponding to this user to **Yes**. To re-activate a user, simply switch **Active ?** button corresponding to this user to **No**.

The main consequences for the suspended users are:
- Their past activities, comments and likes will be remained.
- Their account will neither be listed nor searchable in any applications or the suggestions list when someone mentions.
- The suspended users will no longer receive any email or on-site notifications.

To see all suspended users, select **All** or **Suspended** from the Status drop-down menu and click on **Search** button.

### 8.2 Manage groups

Select the *Groups* tab which is used to add, edit or delete a group. Default main groups are: Development, Organization, Platform, and Spaces.

By default, all existing groups will be displayed on the left panel. The right panel shows information of the selected group and of its members with the **Add Member** form.

1. To add a new group select the path and click the group from the left panel or by clicking 🗂️ if you want to create a group at a higher level. The selected path is displayed in the breadcrumb bar.
2. The **Add New Group** form will be displayed in the right panel. Fill in the required fields.
3. Click **Save** to accept creating the new group. Once being saved, the Group Name cannot be edited.
The creator of a new group will automatically become the manager of that group. The creator's username will be added to the created group with the "manager" membership.

To edit the properties of a group or subgroup by select it and click . You cannot delete the mandatory groups, including Platform, Platform/Administration, Platform/Guests, Platform/Users.

Deleting a group: Simply select the group you want to delete in the left panel. Click and select OK in the confirmation message.

**NOTE:** After being deleted, all information related to that group, such as users and navigation, is also deleted.

**To add a user to a group**

1. Select the group to which you want to add a new user in the left panel. The Group Info panel with the **Add member** form will be opened.
2. Enter the exact **Username** of the user that you want to add to the selected group (you can add many usernames separated by commas); or click to select your desired users from the **Select User** form.
3. Select the membership for the users from the **Membership** drop-down menu.
4. Click **Save** to accept adding the selected users to the specific group with the specified membership type.

**NOTE:** By default, the "manager" membership has the highest right in a group. A user can have several membership types in a group. To do that, you have to use the **Add Member** form for each membership type. The user's membership information is hereafter updated. You can check it by opening the Users form and editing the user you just added.

Under the Spaces group you will see a list of all workspaces and their members. If you select the * membership for a user in any space group, the user will have the right to access the corresponding **Space Settings**. Besides, this user will be listed as a manager in the **Members** tab as well as an administrator in the member list of the space.

You can add user groups (outside spaces) corresponding to your organisational structure: Communication, Program directors, etc. Such user groups will not create a new space, but can be invited to access a workspace as members.
8.3 Membership types

By default, the "manager" membership has the highest right in a group. A user can have several membership types in a group. To do that, you have to use the Add Member form for each membership type. The user's membership information is hereafter updated. You can check it by opening the Users form and editing the user you just added.

By default, 9 membership types are available in eXo Platform including Member, Author, Editor, Manager, Redactor, Validator, Webdesigner, Publisher, and *.

Select the Memberships tab. Here, you can manage user roles in a specific group.

The * membership is identical to any other type, so choosing this type means adding all available membership types. The * membership type is not allowed to be deleted or edited.

You can CREATE A NEW SITE only when you are a member of the /platform/administrators group.

To add a new membership, enter values into the fields of the Add/Edit Membership form. The Membership name field is required and only letters, digits, dots, dashes and underscores are allowed without ANY SPACES. Click Save to accept adding a new membership, or Reset to clear entered values.

Editing a membership type by:

1. Click corresponding to the membership type you want to edit in the Action column.
2. Make your desired changes on the Description field. You cannot change the Membership name.
3. Click Save to accept your changes.

Deleting a membership type by simply clicking in the Action column, then click OK in the confirmation message.
8.4 Permission management (type, levels)

Permissions play an important role in accessing and performing actions in eXo Platform. Depending on the permissions assigned by administrators, users can gain the Access and/or Edit permissions to sites, pages and various components of the sites.

Permission types (access, edit, move apps, move containers)

In eXo Platform, permission types define what a user can do within a site, including:

- **Access permission** enables users to access sites, pages or applications and content in the site pages. This permission can be set for multiple member groups.
- **Edit permission** enables users to make changes on sites, pages or applications and content in the site pages. This permission is set for only one group at one time.
- **Move Apps permission** enables users to add, delete or move applications on sites and pages via drag and drop. This permission can be set for multiple member groups.
- **Move Containers permission** enables users to add, delete or move containers on sites and pages via drag and drop. This permission can be set for multiple member groups.

Permissions levels (site, page, application, container)

Permission levels specify where the users' permission types can be applied in the site.

- **Site**: The permission at the site level defines actions permitted on the site. Users with the access permission can view (but not edit) the site. Meanwhile, users with the edit permission at the site level can modify the site.
- **Page**: The permission at the page level restricts users to several particular pages. Users are only able to see and/or edit pages they have been granted, depending on the permission type assigned to them.
- **Application**: The permission at the application level defines who can access the application.
- **Container**: An application, page, or site may be put into one or more containers. The permission at the container level restricts the Access permission to content inside it.

With these permission types and levels, administrators can effectively control who can access and which actions users can perform within the site. For this reason, you, as an administrator, need to clarify the layered architecture of a site to grant appropriate permissions to groups. The simplest way to understand is that:

A site consists of one or more pages. These pages may be put into one or more containers.

Each page normally contains content and/or application(s). These content and applications may be put into one or more containers.

If you want members under a group (platform/guests, for example) to be accessible to one application on a site page, grant the Access permission to that group at the following layers:

- The application and its containers
- The page and its container where the application is stored.
- The page site and its containers.
In the case you only grant the Access permission to the platform/guests group at the site and page layers, this group will see the page, but not see the applications and content restricted in that page. For more details and example consult the eXo Platform User Guide.

9. Content administration

Only administrators and web contributors can access the **Content Administration** page to manage all workspaces, drives, node types, metadata, templates, queries, and more.

To access the Content Administration page, click on the top navigation bar and then select *Content ➔ Content Administration* from the drop-down menu. The Content Administration page will appear.

From this page, you can access:

1. **Templates** : Manage templates of documents, CLV and metadata.
2. **Explorer** : Manage views, drives and tags.
3. **Repository** : Manage namespaces, node types and locks.
4. **Advanced** : Manage categories, queries, scripts and actions.

The detailed description of these functions can be found in the eXo Platform 4.4 User Guide.

9.1 Documents

The space application *Documents* can be customised based on the needs of the project. The customisation is possible via the **Content Explorer** menu, the technical term for *Documents*.

In Explorer administrator can manage Views, Drives and Tags.
**Explorer views**

eXo Platform provides various drives to store and manage the content efficiently. Each drive has some views that enable viewing data in the drive in a particular way.

Each view has some action tabs and each action tab contains some functions. The number of view types depends on which drive you are browsing.

In Explorer, select **Views** to open the Views panel.

<table>
<thead>
<tr>
<th>Name</th>
<th>Permissions</th>
<th>Action Tab</th>
<th>Base Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Any in Administrators</td>
<td>[Admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td>Any in Web contributors</td>
<td>[Collaboration]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Icons</td>
<td>Any in Users</td>
<td>[Icons]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List</td>
<td>Any in Users</td>
<td>[List]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>Any in Web contributors</td>
<td>[Authoring]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here, you can view, edit, delete, and add new views.

The difference between **Icons View** and **List View** is displayed here:

To learn about differences between these views, see the following table:
In this table, it is visible that each Explorer view has a default set of actions. These views and actions can be customised.

### Manage actions

To view a View simply click ![icon](corresponding to your desired view in the Action column. The View form will open.

To edit View properties click ![icon]( in the Action column. The Edit View form appears.

<table>
<thead>
<tr>
<th>View names</th>
<th>Default actions</th>
<th>Default templates</th>
<th>Default permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Add Folder, Edit Document, View Permissions, Manage Actions, Manage Auditing, Manage Relations, Show JCR Structure, Upload, View Metadata, View Properties</td>
<td>List</td>
<td>*:/platform/administrators</td>
</tr>
</tbody>
</table>

In the View tab:

- You cannot change the view name.

- If you select the Enable Version checkbox, this view automatically increases to one version after you have clicked **Save**. It is displayed at the Base Version column in the Views tab. Moreover, the
View tab in the Edit View form will have the Restore Version field which allows rolling back a given version.

- By default, the **Hide explorer panel in side bar** checkbox is only selected for the Admin and List views. This means you can use the Explorer tree to browse content from the side bar in the Icons, Categories, and Web views by default. However, in the Admin and List views, you need to deselect these checkboxes first.

Select the **Action** tab to do the following actions:

- Click 🖌 to edit one existing tab. You can add or remove functions on the selected tab by selecting/ deselecting the corresponding checkboxes. Note that you cannot change the tab name.
- Click ⏹ to delete an existing tab.
- Click **Add** to add a new tab to the view.
Optional, select the *Permission* tab to delete the existing permissions or to add new permissions.

*Note: Setting the * membership for a group will allow all users of the group to use this view when exploring documents.*

- Click **Save** to apply all changes in the **View** tab.

### Deleting a view

Click 🗑 corresponding to the view you want to delete, then click **OK** in the confirmation message.

### Adding a view

1. Click **Add View** located at the bottom to open the Add View form.

2. Specify the view name in the **Name** field that must be unique, and only contains standard alphanumerical characters. This field is required.
3. Select one template from the **Template** drop-down menu. Optional, tick the **Enable Version** checkbox if you want to activate versioning for your view.

4. Select the **Action** tab, then click **Add** to create a functional tab on this view. This step is required. The **Add/Edit** Tab form appears.

![Add/Edit Tab](image)

- Enter the name for the tab in the **Tab Name** field.
- Tick checkboxes corresponding to the actions you want to add to the tab.
- Click **Save** to finish creating a tab.

The newly created tab is displayed in the Tab column.

![Add View](image)

5. Select the **Permission** tab and then click **Add** to add permissions for the view. It is required.

6. Click **Save** to finish adding your view.
**Document drives**

Drive is a shortcut to a specific location in the content repository that enables administrators to limit visibility of each workspace for groups of users. It is also a simple way to hide the complexity of the content storage by showing only the structure that is helpful for users.

<table>
<thead>
<tr>
<th>Name</th>
<th>Workspace</th>
<th>Home Path</th>
<th>Permissions</th>
<th>View</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collaboration</td>
<td>collaboration</td>
<td>/</td>
<td>Any in Web contributors</td>
<td>Admin</td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>collaboration</td>
<td>/Groups$\langle$groupId$\rangle$/Documents</td>
<td>Any in $\langle$groupId$\rangle$</td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Managed Sites</td>
<td>collaboration</td>
<td>/sites</td>
<td>Any in Administrators</td>
<td>Web</td>
<td></td>
</tr>
<tr>
<td>Personal Documents</td>
<td>collaboration</td>
<td>/Users $\langle$userid$\rangle$/Private</td>
<td>Any in Administrators</td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Trash</td>
<td>collaboration</td>
<td>/Trash</td>
<td>Any in Administrators</td>
<td>Admin</td>
<td></td>
</tr>
<tr>
<td>User Documents</td>
<td>collaboration</td>
<td>/Users $\langle$userid$\rangle$</td>
<td>Any in Administrators</td>
<td>List Icons Admin</td>
<td></td>
</tr>
</tbody>
</table>

For the SMaP purpose, the **Groups** drive is significant, meaning the function of the **Documents** application in workspaces.

**Editing a drive**

1. Click corresponding to your desired drive in the Action column. The **Edit Drive** form appears.
2. Edit the properties as required.
3. Click **Save** to commit your changes.

Select the **Apply Views** tab and select the view types you want to be available in the drive.
The customisation of Explorer settings results in this *Documents* interface:

1. **Address bar** on the top
2. **Sidebar** on the left (the document navigation tree)
3. Document **browsing window** in list/icon view and the action bar.

**Permission settings**

Depending on the workflow, portal and workspace administrators are allowed to change permission settings of the objects in *Documents* to facilitate the collaboration.

1. Select content/object and then click to open the **Permission Management** form.
2. Select a user or a membership or everyone whom you want to assign permissions by clicking the user, group or membership type icon.
3. Select right(s) you want to grants by ticking the corresponding checkboxes.
4. Click **Save** to accept your changes. The new permissions will appear in the permissions table above.

**NOTE:** When you select Modify Right or Remove Right only, the Read Right will be ticked automatically. When ticking any permissions above (Modify, Remove or Read only), if you set the * membership for a group, this permission will be granted to all users of the group, regardless of their membership role.
9.2 Manage sites and pages

If you belong to members of editor or administrator groups, you will see Edit menu on the top navigation bar. By clicking this button, you will see a drop-down menu that allows you to edit content, pages and site quickly.

Click Content from the drop-down menu to turn on the Edit mode. In the Edit mode you are able to edit directly the page without having to change to the web content view. Hover your cursor over Page, then click on Edit Layout, Add Page, or SEO if you want to manage SEO (Search Engine Optimization). Since SMaP is an intranet portal without an extranet, there is no need to manage SEO, i.e. to improve the visibility of your web pages and web content in the major search engines (such as Google, Yahoo, Ask, Bing, and more) via the search results. For site editing however your cursor over Site, then click Layout to edit the site's layout, Navigation to manage navigation, or Add Site to add a new site.

Add new site

Click Administration → Portal → Sites on the top navigation bar and then click Add New Site in the Manage Sites page

OR

1. Click Edit → Site → Add Site to create a new site. By default, the window to create a new site, which contains the Portal Settings tab, will open.
2. Fill in the Portal Name field. The field is required, unique and must start with a letter. Only alphabetical, numerical, dash and underscore characters are allowed for this field with the length from 3 to 30 characters.

3. Select the default display language for the site from the Locale field.

4. Click the Properties tab to set the properties of a site. Keep session alive keeps the working session for a long time to avoid the time-out. There are 3 options: Never, On Demand, and Always. Show info bar by default ticks the checkbox to show the info bar of the portlet by default when the portlet is used in a page of the site.

5. Click the Permissions tab to set permissions on the site. The list of Access permissions for the portal is empty by default. You have to select at least one or tick the Everyone checkbox to assign the Access permission to everyone.

6. Click the Portal Templates tab to select the template for your site.

7. Click Save to accept creating your new site.

After creating a new site, you can access it via the URL format: http://{domain-name}/portal/[name-site].

Editing and deleting a site

To edit a site’s layout
1. Click Edit Layout corresponding to your desired site on the Manage Sites panel
   Or, click Edit → Site → Layout on the top navigation bar. The Edit Layout form will display.
2. To add a new application/container to the site, drag and drop it from the Edit Inline Composer window to the main site body.
   - To rearrange elements in the site body, drag and drop them into your desired positions.
   - To edit or remove any element, hover your cursor over it, then select the Edit or Delete icon respectively.

To edit site’s navigation
1. Click Edit Navigation corresponding to your desired site on Manage Sites form;
   Or, click Edit → Site → Navigation on the top navigation bar. The Navigation Management form appears.
2. Hover to the content you want to edit and right-click on it. Menu with actions will appear.
3. Click Save to save changes.

The configurations of a site include settings, properties and permissions that can be set by clicking Edit Site Configuration in the Manage Sites panel. The Edit window with the Portal Settings tab appears. In this window, you can make changes on fields in the various tabs, except the Portal Name field in the Portal Settings tab.
Deleting a site
1. Go to Administration → Portal → Sites
2. Click Delete icon corresponding to the site you want to delete.
3. Click OK in the confirmation message.

Add new page

Before diving into how to add a new page, you need to clarify the relationship between navigation node and page. Node and page are two entities that are totally different and a node can be referenced to a page. A page can only be accessed by users via a node.

Using Page Creation Wizard

The Page Creation Wizard is available to the portal’s administrators and facilitates them to create and publish portal pages quickly and easily. In this way, you are creating a navigation node and its page together. The whole process to create a new page can be divided into 3 specific steps:

Step 1: Selecting a navigation node and creating the page

1. Open the site to which you want to add a new page. You will be switched to your selected site only after a few seconds.
2. Click Edit on the top navigation bar, and then select Page → Add Page from the drop-down menu to open the Page Creation Wizard form.

   The wizard is divided into two sections:
   • The left panel contains existing pages/nodes displayed in the tree hierarchy. Here, you can navigate up and down the node/page structure.
   • The right panel displays Page Editor where you can make changes on the selected navigation node. You can input parameters for your new page in this panel.
3. Click Next or number ‘2’ of the wizard steps to go to Step 2.

Step 2: Selecting a page layout template

1. Select Empty Layout or click the down-arrow icon in the left panel to see more templates and select one.
2. Click Next or number ‘3’ of the wizard steps to go to the last step.

Step 3: Arranging the page layout

   • Add your desired applications, containers or gadgets by dragging and dropping them from Page Editor to the main page body.
• Rearrange elements in the page body by dragging and dropping them into your desired positions. Also, you can edit or remove any element by hovering your cursor over it and selecting editing icon, or delete icon respectively.
• View page properties by clicking View Page Properties at the bottom of the Page Editor window.
• Preview your changes by clicking Switch View Mode.
• Click Save icon in the Page Editor window to save all changes, or click cancel X to close without saving your changes.

Applications - This tab lists all existing categories and their portlets that you easily can drag and drop into the container.

Containers - This tab contains all existing containers to build your page layout. You can add a container to your page area by dragging and dropping available containers from Page Editor to the main page body. There are various layouts available, including Rows Layout, Columns Layout, Autofit Columns Layout, Tabs Layout and Mixed Layout.
Using Pages Management

In this way, the page only will be created. Thus, to make this page accessible, you need to create a node that links to this page (in the Page Selector tab). See below.

1. Go to administrator menu Administration → Portal → Pages.
2. Select Add New Page button at the bottom. The form with the Page Settings tab opened will display as below.

3. Define the page layout in the Page Layout tab.
4. Define permissions in the Permissions tab. This tab consists of four sub-tabs named Access, Edit, Move Apps and Move Containers.
   • The Access tab shows all users who can access the page:
     o If the value of the Owner Type field is "Portal", the name of the current portal is automatically selected for the Owner Id field, so that the Access permission is assigned to all users who can access the current portal.
     o If the value of the Owner Type field is "Group", the Access permission is assigned to all users who are the members of the group that is selected in the Owner Id field of the Page Settings tab.
   • The Edit shows all users who have the Edit permission on the page.
     o If the value of the Owner Type field is "Portal", the Edit permission is assigned to users who can edit the current portal.
     o If the value of the Owner Type field is "Group", the Edit permission is assigned to all users who are the members of the group that is selected in the Owner Id field of the Page Settings tab.
5. Click Save to accept creating a new page.
To add new node:

1. Go to the page where the node should be added

2. Go to administrator menu Edit → Site → Navigation

3. Select the page/node in the tree navigation and Add New Node to create a node as a sub-node of the selected node; or

   If you want to create a new node at the root level of the portal, click ☞ then right-click the empty space and select Add New Node; Or, simply click Add Node.


5. Select a page for this node in the Page Selector tab if you want.

   • If the corresponding page is not created yet, you can select Create Page, input the name and title for the page.

   • If the page already exists, you can select Search and Select Page, you do not need to enter values in these fields. They are automatically recorded after you have selected an existing page from the Select Page form. This window lists all existing pages of Portal or Group with basic information for each page. You can select a page for creating a node by simply checking the box, or search for a specific page.

     After selecting a page, you will see the page details in the Page Selector form.

6. Select one icon in the Icon tab if you want.

7. Click Save to accept the new node page, or X to close the form.
**Edit and delete page**

Editing the page requires the same steps as editing the site (see section Editing and deleting a site).

1. Open the **Navigation Management** form by doing the steps in the Editing navigation section.
2. Right-click your desired node and select **Edit Node’s Page** from the drop-down menu.

**OR via Pages Management page:**

1. Go to **Administration → Portal → Pages**
2. Click on **Edit icon** of the corresponding to the page you want to edit.
3. The **Edit Page** form will be displayed in the **Page Properties** window.
4. Click **View Page Properties** in the **Page Editor** window to edit the page properties.

In the **Page Settings** tab, you cannot change values in Page Id, Owner Type, Owner Id and Page Name.

In the **Permissions** tab, you can change or add more Access, Edit, Move Apps and Move Containers permissions.

**NOTE: This form is only supported for pages of a group or a portal. Because the user’s page is private, no one can access or edit it, except the creator.**

Deleting a page is possible via the **Pages Management** page.

1. In the list of all existing pages, click **Delete icon** in the row of the page you want to delete.
2. Click **OK** in the confirmation message.
9.3 Manage web content

Only administrators and web contributors can access the Content Administration page to manage all workspaces, drives, node types, metadata, templates, queries, and more.

Create new content

To create new web content go to Administration ➔ Content ➔ Sites Explorer

1. Select Drive Sites Management (it’s usually a default)
2. Under folder “intranet” create New Folder, e.g. EVS webpages
3. In the new folder create New Content and select template “Web Content”
4. Add name and content
5. Save changes

NOTE: it is possible to create subfolders
Once you create a Web Content, a structure containing 5 default subfolders is created automatically:

- **css** - If you want to add a CSS (stylesheet) for your content click on the css folder and upload the new stylesheet. OR go to *Advanced* tab in the view pane and enter the css code.
- **default.html** – To save time, you can replace the html file with an existing one, if applicable.
- **documents** – this folder is useful for documents which are linked in the content file and/or should be accessible.
- **js** – Java Script data are used to make web content more animating and dynamic. You can either edit/replace the default.js file OR go to *Advanced* tab in the view pane and enter/edit the java script code.
- **medias** – this folder contains three subfolder (audio, videos, images), where you can upload & save the corresponding media objects to this particular content in a structured way.
Edit content

There are two ways of editing web content:

- via Administration menu
- via Edit menu

To edit the web content file via Administration menu: Content ➔ Sites Explorer ➔ Site Management Drive

1. Click on the file – the Document View will open automatically
2. Go to dropdown menu More and select Edit - the Web Content editing form will appear
3. Edit the content – here you can edit all the content but the title of the file
4. Save changes

NOTE: While editing procedure a chain symbol will appear next to the file (navigation). This means that the file is currently locked and no simultaneous editing by other web contributors is possible.
To edit the web content file via Edit menu:

1. Click on Edit menu
2. Check the box “Content” to activate the editing mode
3. Hover cursor to the content object and click on the “Edit in Content Explorer” icon. The Editor page will open
4. Click Save or Save & Close to save the changes
5. Click on Back arrow icon to go back to webpage preview

Another option is to hover cursor to the content object and click on it – the editing Toolbar will appear.

Here you can directly adjust the content. Click on ✔ to save the changes OR ✗ to cancel.
Publish content

After editing, the content must be published to be visible for the portal community. Edited content is recognizable via the changed header from Published to Draft mode and the new set of icons.

- Click on to publish the content.

OR

- If you are editing in the Content Explorer or Web Content form, go to More dropdown menu and select Publish.

The content objects that are linked in the content (text) should be stored in the same folder. For this:

1. Go to the respective Web Content file and click on it
2. Select the folder medias or documents, depending on the object
   In case you want to add a media file in medias choose between videos/ images/ audio
3. In dropdown menu More select Upload
4. Select file in the file browser window and click Open
   Below the content view window, a notification bar appears telling that the file has been uploaded. Note: In case of duplicate files, you can keep both, replace it or cancel.
(1) The file is added directly to the list of files. The Status “Draft” indicated that it is not published yet, i.e. it’s not publicly visible in the web page.

(2) **Double-click** on the file to open its preview

(3) Click on **More** dropdown menu and select **Publish**

(4) You have the possibility to download the file, manage permissions, edit properties etc.

*Deleting web content*

This function is used to remove web content from the web contents folder of a specific site's drive.

1. In the content navigation tree Right-click the name of the web content that you want to delete and then select **Delete** from the drop-down menu.

2. Click **Delete** to accept your deletion in the confirmation message.

**9.4 Unified Search**

As portal administrator you are able to manage the content that should be searched for through the unified search feature. To do so,

1. Go to administration menu **Administration ➔ Content ➔ Search**
2. **Search Administration** page appears with the list of searchable content types
3. Click on **Disable** button to turn off the search ability of a specific content type.
10. Communication management

In survey project, the project manager or the coordination team is responsible for managing the collaboration between teams on the portal. Secure communication structures and information transfer are essential for a functional intranet portal. There are several ways of managing communication between and within teams.

NOTE: Detailed description of each feature is given in SMaP User Manual.

10.1 General information channels

Web content

Web page or a site offers a variety of options for sharing important information and provide links to online or downloadable information. Examples can be displaying an interactive fieldwork progress Excel table or graphs, install announcement gadget to share recent news about the project, or add links to external websites.

Notification settings

Notifications are crucial way to receive information about the recent activities, even offline through email notifications. Admin decides which notification streams are active. Users can select the type and edit the frequency of notifications.

10.2 Discussion within teams

Workspace activities

Activity Stream is a space application that displays all activities created in workspaces where you are a member. It automatically enables transparent communication and workflow and is the fastest way to share information and documents with other workspace members or ask for their help or ideas. It is not possible to customise functions of Activity Stream application without code modification.
**Space chat**

While the Activity Stream is more appropriate for documenting activities, either via automatically triggered notification messages or manually posted messages, a workspace chat is more convenient communication environment in form of instant messaging. It is an easy way of starting a discussion with the whole group or, if necessary, with selected members of the portal by creating a discussion room (refers to global chat).

**Forum**

Discussions that need thematic structure and documentation can take place within the Forums application, which is designed for the group discussion and user-generated content in which participants with common interests can exchange their opinions on a subject.

In Forums, the role of each user group is clear and very important. Each role has a set of tasks that they can execute. Administrators and moderators are responsible for setting up and maintaining Forums.

With the highest rights, administrators are in charge of the entire management tasks. In other words, administrators have the global role of doing significant jobs, including:

- **Setting up the Forum portlet**: Steps to configure the Forum portlet, how to specify the category scoping, to enable/disable the Forum components and a bookmarkable Forum URL.
- **Managing categories**: Steps to add, edit and delete a category.
- **Managing forums**: Steps to add a new forum, to configure the moderation settings and to delete a forum.
- **Managing users**: Steps to promote a user, to modify the forum settings, and to ban users.
- **Administrative tasks**: Details about how to configure Sort settings, to define censored keywords, to customize email notifications/BBCodes, to set up auto-pruning, to ban IPs, and to back up a category/forum.

The user interface will indicate which features are available to you, based on your role.

Please consult User Manual for description of functions.

**Wiki**

The Wiki application provides the content productivity to portal users as a tool to forge the unstructured knowledge. With Wiki, you can create and edit pages by using a simplified markup language or a WYSIWYG editor. Wiki along with Forums will complete the ideal combination that helps users enhance their experiences on collaboration activities and build valuable knowledge center.

Space is a set of pages, so the spaces partitioning means that spaces are independent trees. This separation enables Wiki to provide knowledge spaces for different groups.
There are 2 wiki types:

- **Intranet wiki**: The global wiki of the portal. An Intranet wiki is published for every user who can access that portal.
- **Group wiki**: The wiki of a space. A group wiki can be understood as a space wiki. The wiki application of a space works as a group wiki for that space. The group wiki can be accessed by members of that group.

*NOTE: When “saving notes” in a Chat meeting conversation, the meeting protocol will be generated automatically and saved a Wiki page.*

After opening Wiki, you should see the Wiki homepage as below:

1. The Breadcrumb which shows the page hierarchy.
2. The Wiki administration area which allows administrators only to configure the Wiki settings.
3. The Search box.
4. The pages tree view.
5. The Page Control area which helps users take actions with the current page.
6. The page content.
7. The page information. Click number of attachment(s) to open the Attachments details panel at the bottom of the page. Click Public or Restricted to update the permissions of the page.

Advance settings refer to steps specified for administrators to change space settings, manage permissions and author content via WebDAV.

**Managing a page template**

When adding a new page, you are not required to write the content from scratch. You can start by selecting a page template which is actually a Wiki page with predefined content.

In the Browse menu, click **Wiki Settings** to display the templates management form.
Here, you can perform the followings:
1. Searching for a template  
2. Creating a new template  
3. Editing a template  
4. Deleting a template

Managing permissions
Wiki lets you decide the restrictions to apply on a wiki or a page and to specific users, groups or memberships. So, there are two levels of permissions in Wiki:
• Page Permissions
• Wiki Permissions

The Page Permissions allows you to set the View and Edit permissions for a specific Wiki page.

1. Open a Wiki page that you want to set the permissions.
2. Click More and select Page Permissions from the drop-down menu. The Page Permissions form appears.
Pages are viewableeditable according to the Wiki permission. On each page, a user with the Admin Pages permission will be able to override the view and edit permissions on a specific page. A Page Permissions action appears in the page action menu when the user has the Admin Pages permission.

You can add and delete the View Pages Permission or the Edit Pages Permission for the page. Wiki permissions determine which actions a user can perform. A permission can be assigned to any users, groups or memberships.

To change the Wiki permissions, click Browse and select Wiki Settings from the drop-down list. Select the Permission tab in the Wiki Settings page.
There are some permissions on a Wiki as follows:

- **View Pages**: Specifies who can view and watch pages of this Wiki, its attachments and history.
- **Edit Pages**: Specifies who can edit pages of this Wiki.
- **Admin Pages**: Specifies who have the administration rights on pages of this Wiki.
- **Admin Wiki**: Specifies who can administrate the Wiki permissions and settings.

In the Permission tab, you can Add and Delete Wiki permissions of the users, groups and memberships.

For detailed documentation of the Wiki application please go to eXo Platform User Guide.

### 10.3 Communication across teams

**Global chat**

Chat application is an instant messaging application that allows users to get informed and take action quickly, enabling the real-time collaboration among teams and individuals.

The most intuitive way to use Chat for communication across teams is to open its browser window through the top menu by clicking on the icon 📞 and then Open Chat.

In case you already recived chat instant messages from other users, the desktop notification popup will alert you to new/unread messages. The number of messages received appears next to the chat icon. By clicking on it, a list menu showing the last received message appears.

*NOTE: Desktop notifications are sent only if you gave the permission to receive notifications through the web browser. You are requested to give your permission the first time you access to a chat application.*

When you receive the incoming message notification in real-time while you are online, clicking on the pop-up message redirects you to the corresponding conversation in the Chat application.

Except for installation of the application, there are no exclusive administrator actions in Chat.

Please read the SMaP User Guide for detailed description of the Chat functions.
11. Workflow management

The main task of the project manager (also together with the SMaP administrator) is to develop simple and transparent project workflows with the existing tools.

11.1 Projects and tasks

*Tasks* is a management application for all collaborative activities/tasks providing a useful tool for organising small tasks in a larger structure/milestones. These tasks are organised in groups in *My Tasks, Projects* and *Labels*, allowing individuals and teams to manage tasks and communicate work progress effectively. Users are flexible in choosing the structure for projects, sub projects and the corresponding tasks. SMaP concept forsees building a workflow structure that reflects the SLC tasks for better handling of numerous tasks.

To manage a workflow in Tasks means showing the **Board view** or **List view** of the tasks within a specific project. The Board view is designed only for projects, therefore you need to go to a specific project to see this view. In this view, you can manage tasks as well as the project workflow:

- Each column corresponds to a status of the project workflow.
- The number of tasks in a column is displayed next to the status name.

**Creating new tasks**: In addition, any user can create new tasks can quickly via the Board view as follows:

1. Hover cursor over the last task of a column (or grouping), an editable field will appear
2. Type the task title in this field, then press Enter key. Your new task will be created immediately in the corresponding column.

**Sorting/Grouping tasks**: You can sort these tasks by the *Due Date, Priority* and *Rank* options as well as group them by the *Assignee, Label and None* options as in this view.
Moving tasks: You can drag/drop tasks back and forth between assignees, labels and statuses.

Labelling of project workflow status: In Board view the workflow status can be edited by administrator and creator of the project by clicking on the title field.

11.2 Calendars

Through the calendar application users are able to get an overview of the events structured in groups (Group Calendars).

The 5 basic components of Calendars are:

1. The Toolbar contains most of actions in Calendar, such as adding an event, switching between view modes and more.
2. The Search Pane where you can perform quick and advanced searches.
3. The Mini calendar where you can go backward/forward months by clicking ←/→. Also, you can jump to your desired date by directly clicking that date.
4. The Calendar View pane where you can create events quickly and view your own events.
5. The Calendars pane which includes Group and Task Calendars (Personal Calendars will not be utilised in SMaP)

![Calendar](image)

Project manager can add a common Project “Calendar” and make it accessible to all users and editable only by himself / herself and other relevant actors.

There exists the option of integrating tasks in calendar, i.e. tasks and their properties will appear in calendar under the section Task Calendars.

You can change the Calendar preferences as follows:

1. Open the Calendar Settings form via either of the following ways:
   - **The first way**: Click 📋 on the Calendar toolbar.
   - **The second way**: Click ☰, then select Calendar Settings from the drop-down menu. The Calendar Settings form appears.
2. Change your desired preferences.

*Calendar gadget* is quick application shown on homepage of the portal in the right pane. It provides an agenda overview about the upcoming events and tasks. The number of events shown on the list is configurable by users. For example, they can set the preference list to 5 or 10 events.

*Remote calendar* allows connection to other management programs such as Microsoft Outlook.

### 11.3 (SLC) Folder structure

Survey projects deal with complex review workflows and have to manage number of documents and files. For centralised projects we recommend applying a predefined folder structure in Documents application to ease the file management and the cross-team collaboration – especially between central team and national team (during consultation and fieldwork phase, data deposit and data processing). An example would be a structure of the SLC, like in the image below, where the contact persons are members of both the central team and the national team.

Further, you can set up folders according to tasks or persons responsible.
Such workflow-based folder structure connects country teams and central team across the different phases of the project lifecycle and makes it possible to share files without saving them twice.

**NOTE:** Each folder has its own permission settings that can be adapted by the portal or group/workspace manager.

### 11.4 Overview tables

iFrame tool has been proven to be useful for creating linkage to tables and graphs existing in cloud systems, especially Google Drive. It mirrors these files and enables real-time editing of the documents. It is useful for monitoring processes.

**Tables tool:**

This portlet was designed to enable users for creating any types of table with dynamic UI component. There are two steps to manage tables (1) Creating a table with selecting the name for tables and then assign a user group who needs to edit/view this table (permission settings), (2) construct the dynamic table structure by asking a user the data type, header name, default value for each cell and obligation of the field. Figure below shows the “step 2“ described above and the preview of the created fields in the table.
After creating the table, based on the permission settings users are able to view/edit the tables that they are member of by navigating to “View Tables” in the left navigator.

12. Monitoring and quality assurance

Monitoring and documentation of working processes and production of standardised reports on the actual status of the project is possible on SMaP by using and combining different features.

- Through collaboration tools such as Tasks and Calendar, the team leaders and coordinator team can monitor the progress of specific workflows.
- A (Field)Work progress monitoring web page may be useful for transparent workflows and reporting current status of the project in real time, for example by using the iFrame tool which you can connect to monitoring results on Google Drive.
- Another way of establishing a reporting workflow on SMaP via tables, online forms, and check lists. These are applications developed by GESIS which can be installed and customised for a specific project.

13. Export data

13.1 Use case: user retired

User data is all stored in the RDBMS, and user can partly export contents e.g. wiki and forum to pdf for archiving purposes.

13.2 Use case: project ends

Export data: There are export content options to directly download document and folders using webDav. But webDav must be configured in advanced. Here is the webDav configuration:

```bash
# JCR:webdav configuration
exo.webdav.def-folder-node-type=nt:folder
exo.webdav.def-file-node-type=nt:file
exo.webdav.def-file-mimetype=application/octet-stream
```
Also each tool separately support the export mechanism e.g. Calendar, Forum, Wiki, Event, MQ and Table Portlets

**Export metadata:** All the metadata are stored into the database and in this version of SMaP we can not directly export the metadata from the platform.

**Migration and archiving**

As explained in the storage and database section, the architecture supports the migration of instance from one version to another. To this end, you need to copy the three explained JNDI data sources i.e. IDM, JCR and JPA to the right path in the migrating SMaP directory.
APPENDIX

SMaP Properties configuration table. As we explained in configuration section, in order to complete the SMaP setup you need to config the exo.properties. You can find the file in the downloaded SMaP folder under: gatein/config/exo.properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.accountsetup.skip</td>
<td>Skips &quot;account setup&quot; screen or not?</td>
<td>False</td>
</tr>
<tr>
<td>exo.super.user</td>
<td>The predefined super user's name.</td>
<td>Root</td>
</tr>
<tr>
<td>exo.portal.resetpassword.expiretime</td>
<td>The expiration time of a reset password link.</td>
<td>24 (hours)</td>
</tr>
<tr>
<td><strong>SMTP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.email.smtp.from</td>
<td>The &quot;From&quot; field in outgoing emails.</td>
<td><a href="mailto:seriss@gesis.org">seriss@gesis.org</a></td>
</tr>
<tr>
<td>exo.email.smtp.host</td>
<td>The external mail server.</td>
<td>localhost</td>
</tr>
<tr>
<td>exo.email.smtp.port</td>
<td>The external mail server port.</td>
<td>25</td>
</tr>
<tr>
<td>exo.email.smtp.starttls.enable</td>
<td>Enable TLS or not?</td>
<td>False</td>
</tr>
<tr>
<td>exo.email.smtp.auth</td>
<td>Enable SMTP authentication or not?</td>
<td>False</td>
</tr>
<tr>
<td>exo.email.smtp.username</td>
<td>Username to get authenticated with the mail server.</td>
<td></td>
</tr>
<tr>
<td>exo.email.smtp.password</td>
<td>Password to get authenticated with the mail server.</td>
<td></td>
</tr>
<tr>
<td>exo.email.smtp.socketFactory.port</td>
<td>Port to connect to if a socket factory is specified.</td>
<td></td>
</tr>
<tr>
<td>exo.email.smtp.socketFactory.class</td>
<td>A class to create SMTP sockets.</td>
<td></td>
</tr>
<tr>
<td><strong>JODConverter</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.jodconverter.enable</td>
<td>Enable JODConverter or not?</td>
<td>True</td>
</tr>
<tr>
<td>exo.jodconverter.portnumbers</td>
<td>List of ports used to create soffice processes.</td>
<td>2002</td>
</tr>
<tr>
<td>exo.jodconverter.officehome</td>
<td>The home folder of the Office installation.</td>
<td>Blank (auto-detected)</td>
</tr>
<tr>
<td>exo.jodconverter.taskqueuetimeout</td>
<td>The maximum living time in milliseconds of a task in the conversation queue.</td>
<td>30000</td>
</tr>
<tr>
<td>exo.jodconverter.taskexecutiontimeout</td>
<td>The maximum time in milliseconds to process a task.</td>
<td>120000</td>
</tr>
<tr>
<td>exo.jodconverter.maxtasksperprocess</td>
<td>The maximum number of tasks to process by an office server.</td>
<td>200</td>
</tr>
<tr>
<td>exo.jodconverter.retrytimeout</td>
<td>The interval time in milliseconds to try to restart an office server in case it unexpectedly stops.</td>
<td>120000</td>
</tr>
<tr>
<td><strong>Search connector</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.[searchConnectorName].connectore.[informationType].enable</td>
<td>Turn on/off a specific Search connector for a certain information type.</td>
<td>True</td>
</tr>
<tr>
<td>Unified Search</td>
<td>Enable fuzzy search or not?</td>
<td>True</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-----------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>exo.unified-search.engine.fuzzy.enable</td>
<td>A float number between 0 and 1 expressing how much a returned word matches the keyword. 1 is exact search.</td>
<td>0.5</td>
</tr>
<tr>
<td>exo.unified-search.engine.fuzzy.similarity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.unified-search.excluded-characters</td>
<td>List of characters that will not be indexed (so could not be searched).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notification</td>
<td>Cron expression to schedule daily emails.</td>
<td>0 0 23 ? * * (11:00pm every day)</td>
</tr>
<tr>
<td>exo.notification.NotificationDailyJob.expression</td>
<td>Cron expression to schedule weekly emails.</td>
<td>0 0 11 ? * SUN (11:00am every Sunday)</td>
</tr>
<tr>
<td>exo.notification.service.QueueMessage.period</td>
<td>The delay time (in seconds) between two batches of sent mails.</td>
<td>60</td>
</tr>
<tr>
<td>exo.notification.service.QueueMessage.numberOfMailPerBatch</td>
<td>The maximum number of emails sent each batch.</td>
<td>30</td>
</tr>
<tr>
<td>exo.notification.portalname</td>
<td>The &quot;from&quot; field in notification emails.</td>
<td>eXo</td>
</tr>
<tr>
<td>exo.notification.maxitems</td>
<td>Maximum number of notifications displayed in the popup list.</td>
<td>8</td>
</tr>
<tr>
<td>exo.notification.viewall</td>
<td>Living days of items displayed in the View All page.</td>
<td>30</td>
</tr>
<tr>
<td>exo.notification.WebNotificationCleanJob.expression</td>
<td>Cron expression to schedule the job that cleans web notification old items.</td>
<td>0 0 23 ? * * (11:00pm every day)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JCR</td>
<td>In most cases the dialect is auto-detected. Follow the link to know exceptions.</td>
<td>Auto</td>
</tr>
<tr>
<td>exo.jcr.datasource.dialect</td>
<td>Enable file system storage for JCR values?</td>
<td>True</td>
</tr>
<tr>
<td>exo.jcr.storage.enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WebDav</td>
<td>Matching node type of folders.</td>
<td>nt:folder</td>
</tr>
<tr>
<td>exo.webdav.def-folder-node-type</td>
<td>Matching node type of files.</td>
<td>nt:file</td>
</tr>
<tr>
<td>exo.webdav.def-file-node-type</td>
<td>The mimetype to exchange file data.</td>
<td>application/octet-stream</td>
</tr>
<tr>
<td>exo.webdav.update-policy</td>
<td>The policy applied when there is an update via WebDav.</td>
<td>create-version</td>
</tr>
<tr>
<td>exo.webdav.folder-icon-path</td>
<td>The display icon of a folder.</td>
<td>/eXoWCMResources/skin/images/file/nt-folder.png</td>
</tr>
<tr>
<td>exo.webdav.cache-control</td>
<td>The cache-control header that defines cache and cache live time.</td>
<td>text/<em>:max-age=3600;image/</em>:max-age=1800;application/<em>/max-age=1800;</em>/:*:no-cache</td>
</tr>
<tr>
<td><strong>ECMS</strong></td>
<td><strong>EXO</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------</td>
<td>----</td>
<td>----------------</td>
</tr>
<tr>
<td>exo.ecms.connector.drives.upload Limit</td>
<td>Maximum size (in MB) allowed of an uploaded file.</td>
<td>200</td>
</tr>
<tr>
<td>exo.portal.uploadhandler.public-restriction</td>
<td>Turn on/off public access to the upload service.</td>
<td>True</td>
</tr>
<tr>
<td>exo.ecms.connector.drives.client Limit</td>
<td>The maximum number of concurrent uploaded files in client side.</td>
<td>3</td>
</tr>
<tr>
<td>exo.ecms.connector.drives.server Limit</td>
<td>The maximum number of concurrent uploaded files in server side.</td>
<td>20</td>
</tr>
<tr>
<td>exo.ecms.search.excluded-mimetypes</td>
<td>Content of these mimetypes will not be searched.</td>
<td>text/css, text/javascript, application/javascript, text/ecmascript</td>
</tr>
<tr>
<td>exo.ecms.search.enableFuzzy Search</td>
<td>Enable fuzzy search or not?</td>
<td>True</td>
</tr>
<tr>
<td>exo.ecms.search.fuzzySearchIndex</td>
<td>A float number between 0 and 1 expressing how much a returned word matches the keyword. 1 is exact search.</td>
<td>0.8</td>
</tr>
<tr>
<td>exo.ecms.lock.admin</td>
<td>Users or groups who can manage locks.</td>
<td>*/platform/administrators</td>
</tr>
<tr>
<td>exo.ecms.friendly.enabled</td>
<td>Enable friendly URL maker or not?</td>
<td>True</td>
</tr>
<tr>
<td>exo.ecms.friendly.servletName</td>
<td>The friendly name used when making friendly URLs.</td>
<td>Content</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ECMS Watch Document</strong></th>
<th><strong>EXO</strong></th>
<th><strong>Description</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.ecms.watchdocument.sender</td>
<td>The &quot;from&quot; field in the notification emails.</td>
<td><a href="mailto:support@exoplatform.com">support@exoplatform.com</a></td>
<td></td>
</tr>
<tr>
<td>exo.ecms.watchdocument.subject</td>
<td>The subject of the notification emails.</td>
<td>&quot;Your watching document is changed&quot;</td>
<td></td>
</tr>
<tr>
<td>exo.ecms.watchdocument.mime-type</td>
<td>Mimetype of the message body.</td>
<td>text/html</td>
<td></td>
</tr>
<tr>
<td>exo.ecms.watchdocument.content</td>
<td>The message body.</td>
<td>Check it yourself in exo-sample.properties</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ECMS Document versioning</strong></th>
<th><strong>EXO</strong></th>
<th><strong>Description</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.ecms.documents.versioning.drives</td>
<td>The drives that are enabled for Document versioning.</td>
<td>Managed Sites, Groups, Personal Documents</td>
<td></td>
</tr>
<tr>
<td>exo.ecms.documents.versions.max</td>
<td>The max number of versions that a document can have.</td>
<td>0 (no limit)</td>
<td></td>
</tr>
<tr>
<td>exo.ecms.documents.versions.expiration</td>
<td>The expiration time (in days) of a document version.</td>
<td>0 (no limit)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ECMS Document Viewer</strong></th>
<th><strong>EXO</strong></th>
<th><strong>Description</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.ecms.documents.pdfviewer.max-file-size</td>
<td>Max file size of documents for preview, in MB</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>exo.ecms.documents.pdfviewer.max-pages</td>
<td>Max number of pages of documents for preview</td>
<td>99</td>
<td></td>
</tr>
</tbody>
</table>
### Calendar

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.calendar.default.event.suggest</code></td>
<td>An integer number n, used to auto-calculate and suggest the end time when users create/edit an event.</td>
<td>2 (equivalent to 1 hour)</td>
</tr>
<tr>
<td><code>exo.calendar.default.task.suggest</code></td>
<td>An integer number n, used to auto-calculate and suggest the end time when users create/edit a task.</td>
<td>1 (equivalent to 30 mins)</td>
</tr>
</tbody>
</table>

### Site metadata

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.intranet.portalConfig.metadata.override</code></td>
<td>Don’t change this unless you customize the Intranet site.</td>
<td>False</td>
</tr>
<tr>
<td><code>exo.intranet.portalConfig.metadata.importmode</code></td>
<td>Don’t change this unless you customize the Intranet site.</td>
<td>Insert</td>
</tr>
<tr>
<td><code>exo.acme.portalConfig.metadata.override</code></td>
<td>Only affect when you install the ACME addon.</td>
<td>False</td>
</tr>
<tr>
<td><code>exo.ide.portalConfig.metadata.override</code></td>
<td>Only affect when you install the IDE addon.</td>
<td>True</td>
</tr>
</tbody>
</table>

### Datasource

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.jcr.datasource.name</code></td>
<td>JCR datasource name.</td>
<td>java:/comp/env/exo-jcr</td>
</tr>
<tr>
<td><code>exo.idm.datasource.name</code></td>
<td>IDM datasource name.</td>
<td>java:/comp/env/exo-idm</td>
</tr>
</tbody>
</table>

### Clustering

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.cluster.partition.name</code></td>
<td>Give a string to identify your cluster, to avoid conflict with other clusters in the network.</td>
<td>DefaultPartition</td>
</tr>
<tr>
<td><code>exo.jcr.cluster.jgroups.tcp*</code></td>
<td>JGroups configuration for JCR using TCP.</td>
<td></td>
</tr>
<tr>
<td><code>exo.jcr.cluster.jgroups.udp.*</code></td>
<td>JGroups configuration for JCR using UDP.</td>
<td></td>
</tr>
<tr>
<td><code>exo.idm.cluster.jgroups.tcp*</code></td>
<td>JGroups configuration for IDM using TCP.</td>
<td></td>
</tr>
<tr>
<td><code>exo.idm.cluster.jgroups.udp.*</code></td>
<td>JGroups configuration for IDM using UDP.</td>
<td></td>
</tr>
<tr>
<td><code>exo.jcr.cluster.jgroups.config</code></td>
<td>Path to your customized JGroups configuration file, applied to JCR.</td>
<td></td>
</tr>
<tr>
<td><code>exo.jcr.cluster.jgroups.config-url</code></td>
<td>URL to your customized JGroups configuration file, applied to JCR.</td>
<td></td>
</tr>
<tr>
<td><code>exo.idm.cluster.jgroups.config</code></td>
<td>Path to your customized JGroups configuration file, applied to IDM.</td>
<td></td>
</tr>
</tbody>
</table>
## Quartz Scheduler

### Main Scheduler Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.quartz.scheduler.instanceName</td>
<td>The name of the scheduler instance.</td>
<td>ExoScheduler</td>
</tr>
<tr>
<td>exo.quartz.scheduler.instanceId</td>
<td>The type of the scheduler instance.</td>
<td>AUTO</td>
</tr>
</tbody>
</table>

### ThreadPool configuration Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.quartz.threadPool.class</td>
<td>Is the name of the ThreadPool implementation used.</td>
<td>org.quartz.simpl.SimpleThreadPool</td>
</tr>
<tr>
<td>exo.quartz.threadPool.threadPriority</td>
<td>It an integer value between Thread.MIN_PRIORITY (which is 1) and Thread.MAX_PRIORITY (which is 10).</td>
<td>5</td>
</tr>
<tr>
<td>exo.quartz.threadPool.threadCount</td>
<td>It is the number of threads that are available for concurrent execution of jobs.</td>
<td>25</td>
</tr>
</tbody>
</table>

### JobStore configuration Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.quartz.jobStore.misfireThreshold</td>
<td>The number of milliseconds the scheduler will tolerate a trigger to pass its next-fire-time by, before being considered misfired.</td>
<td>6000</td>
</tr>
<tr>
<td>exo.quartz.jobStore.class</td>
<td>The Scheduler's JobStore class name.</td>
<td>org.quartz.impl.jbdcjobsstore.JobStoreTX</td>
</tr>
<tr>
<td>exo.quartz.jobStore.driverDelegateClass</td>
<td>The Driver delegate which will understand the database system dialect.</td>
<td>org.quartz.impl.jbdcjobsstore.StdJDBCDelegate</td>
</tr>
<tr>
<td>exo.quartz.jobStore.useProperties</td>
<td>The flag which instructs JDBCJobStore that all values in JobDataMaps will be Strings.</td>
<td>False</td>
</tr>
<tr>
<td>exo.quartz.jobStore.dataSource</td>
<td>The name of the DataSources defined in the configuration properties file for quartz.</td>
<td>quartzDS</td>
</tr>
<tr>
<td>exo.quartz.jobStore.tablePrefix</td>
<td>The prefix used for to Quartz's tables in the database.</td>
<td>QRTZ_</td>
</tr>
<tr>
<td>exo.quartz.jobStore.isClustered</td>
<td>Set to &quot;true&quot; in order to turn on clustering features.</td>
<td>False</td>
</tr>
<tr>
<td>exo.quartz.jobStore.clusterCheckinInterval</td>
<td>Set the frequency (in milliseconds) at which this instance &quot;checks-in&quot; with other instances of the cluster.</td>
<td>20000</td>
</tr>
<tr>
<td>exo.quartz.jobStore.maxMisfiresToHandleAtATime</td>
<td>The maximum number of misfired triggers the jobstore will handle in a given pass.</td>
<td>20</td>
</tr>
<tr>
<td>exo.quartz.jobStore.dontSetAutoCommitFalse</td>
<td>Setting this parameter to &quot;true&quot; tells Quartz not to call setAutoCommit(false) on connections obtained from the DataSource(s).</td>
<td>False</td>
</tr>
<tr>
<td>exo.quartz.jobStore.acquireTriggersWithinLock</td>
<td>Whether or not the acquisition of next triggers to fire should occur within an explicit database lock.</td>
<td>False</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>exo.quartz.jobStore.lockHandler.class</td>
<td>The class name to be used to produce an instance of a &quot;org.quartz.impl.jdbcjobstore&quot;.</td>
<td></td>
</tr>
<tr>
<td>exo.quartz.jobStore.driverDelegateInit</td>
<td>A pipe-delimited list of properties (and their values) that can be passed to the DriverDelegate during initialization time.</td>
<td></td>
</tr>
<tr>
<td>exo.quartz.jobStore.txIsolationLevel</td>
<td>A value of &quot;true&quot; tells Quartz (when using JobStoreTX or CMT) to call setTransactionIsolation(Connection.TRANSACTION_SERIALIZABLE) on JDBC connections. This can be helpful to prevent lock timeouts with some databases under high load, and long-lasting transactions.</td>
<td></td>
</tr>
<tr>
<td>exo.quartz.jobStore.selectWithLockSQL</td>
<td>Must be a SQL string that selects a row in the &quot;LOCKS&quot; table and places a lock on the row.</td>
<td></td>
</tr>
<tr>
<td>Datasources configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.quartz.dataSource.quartzDS.jndi</td>
<td>The JNDI URL for a DataSource that is managed by eXo Platform.</td>
<td></td>
</tr>
<tr>
<td>Password Encryption</td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.plidm.password.class</td>
<td>The class that encrypts the user password before it is stored in the database.</td>
<td></td>
</tr>
<tr>
<td>exo.plidm.password.hash</td>
<td>The encrypt algorithm.</td>
<td></td>
</tr>
<tr>
<td>Elasticsearch Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>exo.es.version.minor</td>
<td>The expected minor Elasticsearch version compatible with eXo Platform.</td>
<td></td>
</tr>
<tr>
<td>exo.es.embedded.enabled</td>
<td>Allows to run an Elasticsearch server embedded in eXo Platform (not recommended for production).</td>
<td></td>
</tr>
<tr>
<td>es.network.host</td>
<td>Sets both 'bind_host' and 'publish_host' params.</td>
<td></td>
</tr>
<tr>
<td>es.discovery.zen.ping.unicast.hosts</td>
<td>In Unicast discovery mode, this parameter lets you set a list of master nodes in the cluster to perform discovery when new nodes (master or data) are started.</td>
<td></td>
</tr>
<tr>
<td>es.http.port</td>
<td>TCP Port of the embedded ES node.</td>
<td></td>
</tr>
<tr>
<td>es.path.data</td>
<td>Local path to the directory where to Elasticsearch will store index data allocated for this node.</td>
<td></td>
</tr>
<tr>
<td>Elasticsearch Client</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><code>exo.es.search.server.url</code></td>
<td>URL of the node used for searching. Required and <code>exo.es.embedded.enabled=false</code></td>
<td>&quot;<a href="http://127.0.0.1:9200">http://127.0.0.1:9200</a>&quot;</td>
</tr>
<tr>
<td><code>exo.es.search.server.username</code></td>
<td>Username used for the BASIC authentication on the Elasticsearch node used for searching.</td>
<td></td>
</tr>
<tr>
<td><code>exo.es.search.server.password</code></td>
<td>Password used for the BASIC authentication on the Elasticsearch node used for searching.</td>
<td></td>
</tr>
<tr>
<td><code>exo.es.index.server.url</code></td>
<td>URL of the node used for indexing.</td>
<td>&quot;<a href="http://127.0.0.1:9200">http://127.0.0.1:9200</a>&quot;</td>
</tr>
<tr>
<td><code>exo.es.index.server.username</code></td>
<td>Username used for the BASIC authentication on the Elasticsearch node used for indexing.</td>
<td></td>
</tr>
<tr>
<td><code>exo.es.index.server.password</code></td>
<td>Password used for the BASIC authentication on the Elasticsearch node used for indexing.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Elasticsearch Indexing properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.es.indexing.batch.number</code></td>
<td>Maximum number of documents that can be sent to Elasticsearch in one bulk request.</td>
</tr>
<tr>
<td><code>exo.es.indexing.request.size.limit</code></td>
<td>Maximum size (in bytes) of an Elasticsearch bulk request.</td>
</tr>
<tr>
<td><code>exo.es.reindex.batch.size</code></td>
<td>Size of the chunks of the reindexing batch.</td>
</tr>
<tr>
<td><code>exo.es.indexing.replica.number.default</code></td>
<td>Number of replicas of the index.</td>
</tr>
<tr>
<td><code>exo.es.indexing.shard.number.default</code></td>
<td>Number of shards of the index.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable/Disable activity type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.activity-type.activity-type-key.enabled</code></td>
<td>The property that allows to enable or disable an activity having the type key <code>activity-type-key</code> from posting in the streams.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File storage configuration</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exo.files.binaries.storage.type</code></td>
<td>Allows to define the file storage way: File system (type=fs) or RDBMS (type=rdbms).</td>
</tr>
<tr>
<td><code>exo.commons.FileStorageCleanJob.enabled</code></td>
<td>Enables/disables the job that cleans unused files.</td>
</tr>
<tr>
<td><code>exo.commons.FileStorageCleanJob.retention-time</code></td>
<td>The retention time of unused files</td>
</tr>
<tr>
<td><code>exo.commons.FileStorageCleanJob.expression</code></td>
<td>The cron job expression for scheduling the file cleaner job</td>
</tr>
<tr>
<td><code>exo.files.storage.dir</code></td>
<td>The location where to store binary files in case of file system storage. In cluster mode, this location (folder) should be shared.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>standaloneChatServer</td>
<td>Defines the chat mode: true for the standalone mode and false for the embedded mode.</td>
</tr>
<tr>
<td>dbServerType</td>
<td>MongoDB type: either Mongo or embed. Embed value is used for unit tests.</td>
</tr>
<tr>
<td>dbServerHost</td>
<td>The host name or IP of MongoDB. This parameter is deprecated starting from eXo Platform 5.0 versions and should be replaced by dbServerHosts.</td>
</tr>
<tr>
<td>dbServerPort</td>
<td>The port number to connect to MongoDB host. Same as the previous parameter, this one is also deprecated from eXo Platform 5.0. It is replaceable by dbServerHosts.</td>
</tr>
<tr>
<td>dbServerHosts</td>
<td>The MongoDB nodes to connect to, as a comma-separated list of <a href="">host:port</a> values.</td>
</tr>
<tr>
<td>dbName</td>
<td>Name of the Mongo database name.</td>
</tr>
<tr>
<td>dbAuthentication</td>
<td>Enables or disables authentication to access MongoDB. When set to true this means that authentication is required.</td>
</tr>
<tr>
<td>dbUser</td>
<td>Provide the username to access the database if authentication needed.</td>
</tr>
<tr>
<td>dbPassword</td>
<td>Provide the password to access the database if authentication needed.</td>
</tr>
<tr>
<td>chatServerBase</td>
<td>Base URL of the Chat Server. It is set as the same value of exo.base.url by default. It must be changed when the chat server is installed in standalone mode. For example: <a href="http://127.0.0.1:8081">http://127.0.0.1:8081</a></td>
</tr>
<tr>
<td>chatServerUrl</td>
<td>URL to access Chat Server.</td>
</tr>
<tr>
<td>chatPortalPage</td>
<td>Relative URL of the Chat application.</td>
</tr>
<tr>
<td>chatPassPhrase</td>
<td>The password to access REST service on the eXo Chat server.</td>
</tr>
<tr>
<td>chatCronNotifCleanup</td>
<td>The frequency of cleaning eXo Chat notifications. They are cleaned up every one hour by default.</td>
</tr>
<tr>
<td>chatReadTotalJson</td>
<td>The number of messages that you can get in the Chat room.</td>
</tr>
<tr>
<td>chatIntervalChat</td>
<td>Time interval to refresh messages in a chat.</td>
</tr>
<tr>
<td>chatIntervalSession</td>
<td>Time interval to keep a chat session alive in milliseconds.</td>
</tr>
<tr>
<td>chatIntervalNotif</td>
<td>Time interval to refresh Notifications in the main menu in milliseconds.</td>
</tr>
<tr>
<td>chatTokenValidity</td>
<td>Time after which a token will be invalid. The use will then be considered offline.</td>
</tr>
<tr>
<td>exo.chat.upload.limit</td>
<td>Max size of upload files (in Mb)</td>
</tr>
<tr>
<td>request.timeout</td>
<td>The request timeout in milliseconds of the calls to chat server.</td>
</tr>
</tbody>
</table>
### Groovy templates statistics:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.statistics.groovy.template.enabled</td>
<td>Enables/disables Groovy Templates statistics that is collected asynchronously.</td>
<td>True</td>
</tr>
</tbody>
</table>

### CometD configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.cometd.oort.url</td>
<td>The CometD Oort URL used in clustering mode.</td>
<td>&quot;<a href="http://localhost:8080/cometd/cometd">http://localhost:8080/cometd/cometd</a>&quot;, localhost should be replaced by the hostname or the IP of the cluster node.</td>
</tr>
<tr>
<td>exo.cometd.oort.configType</td>
<td>The CometD configuration type which could be either &quot;static&quot; or &quot;multicast&quot;.</td>
<td>Multicast</td>
</tr>
<tr>
<td>exo.cometd.oort.cloud</td>
<td>A comma-separated list of URLs of other Oort comets to connect to at startup.</td>
<td></td>
</tr>
</tbody>
</table>

### Update of last login time

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.idm.user.updateLastLoginTime</td>
<td>Enables/disables the update of last login time each time the user login.</td>
<td>True</td>
</tr>
</tbody>
</table>

### Define spaces administrators group

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.social.spaces.administrators</td>
<td>Defines the list of spaces administrators groups.</td>
</tr>
</tbody>
</table>

### Assets versions used in static resources URLs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.assets.version</td>
<td>Defines the assets version.</td>
<td>It is set to eXo Platform binary version.</td>
</tr>
</tbody>
</table>

### Username case sensitive

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.auth.case.insensitive</td>
<td>Defines if usernames in eXo Platform are case sensitive or not.</td>
<td>false.</td>
</tr>
</tbody>
</table>

### User inactivity delay

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.user.status.offline.delay</td>
<td>Defines the time laps which makes the user in offline status. Its value is expressed in milliseconds.</td>
<td>240000</td>
</tr>
<tr>
<td>Notifications channels</td>
<td>Defines the activated notification channels.</td>
<td>WEB_CHANNEL, MAIL_CHANNEL</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>exo.notification.channels</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wiki application base URI</th>
<th>Defines the base URI for the wiki application permalinks.</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>wikipermalink.appuri</td>
<td></td>
<td>Wiki</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Files upload limit</th>
<th>Maximum size (in MB) allowed of an uploaded file.</th>
<th>200</th>
</tr>
</thead>
<tbody>
<tr>
<td>exo.ecms.connector.drives.uploadLimit</td>
<td></td>
<td>200</td>
</tr>
<tr>
<td>exo.social.activity.uploadLimit</td>
<td>Maximum size (in MB) allowed of an uploaded image through the CKEditor.</td>
<td>200</td>
</tr>
<tr>
<td>exo.wiki.attachment.uploadLimit</td>
<td>Maximum size (in MB) allowed of an uploaded file in Wiki application.</td>
<td>200</td>
</tr>
</tbody>
</table>